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Introduction

A YouTube element has been excluded from this version of the text. You can view it online here: https_//iastate pressbooks pub/

visualgraphiccomm/?p=4

This Open Educational Resource is for the beginning level of both interior design and architecture students who learn
computer graphic communication software.

The author created and developed a total of 22 tutorials to teach three computer graphic applications, AutoCAD, Revit, and
Enscape. AutoCAD is an essential computer drafting software which is 2D drawing software. Revit is a Building Information
Modeling software, which is 3D based modeling software. Lastly, Enscape is a real-time rendering and virtual reality plug-in
for users’ 4D experiences. These three applications are the primary programs that design students should utilize for his/her
design projects throughout an individual’s academic life in the College of Design and the student’s future jobs.

Many design students rely on the instructor's demonstrations during lectures for acquiring technical knowledge.
Additionally, design students have tutorials from multiple resources such as textbooks and videos from that internet that
are informed by the instructors or the students’ own search results. Typically, a textbook deals with only an application.
And videos from the internet include unnecessary information like commercial advertisements. These separated sources
of information often cause a student’s confusion and frustration. For these reasons, the book provides a unified format of
tutorials to cover the three applications. The tutorials consist of both text and image-based tutorials as the primary resource
and video-based tutorials as the supplemental materials.

An instructor will demonstrate using the text and image-based tutorials, and share the link for the video-based tutorials after
the lectures for student’s practice. This book provides two learning experiences. One is to create an architectural model by
following the instructions provided in this book. The second is to create your own model by referencing the information
from this book.

Students learning outcomes

The tutorials in this book may have positive impacts on students’ learning by 1) providing unified lecture contents to learn
the main three graphic communication applications for design students, 2) offering free and readily available materials, 3)
supporting two different formats of tutorials for different types of learner.

Affordability of the teaching contents

This bool help students’ finance because the materials are free with Creative Common. Whenever students need, the
tutorials will be available without paying for the textbook. Currently, the course uses a textbook for only one application,
Revit. It is because of the price of the textbook, and also the amount of information that the course covers. If the course relay
on textbooks, students in the course should purchase two books, one for AutoCAD and the other for Revit, a textbook for
Enscape is not published yet.

Pedagogical strategies

The author is developing hybrid tutorials to support diverse student’s learning styles. Some students tend to learn lecture
contents through readings, some students learn lecture contents more effectively with video and audio, and some students
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learn lecture contents with in-person coaches. The book implements two types of tutorials to cover visual learners and
auditory learners. The tutorials also can be used for new instructors to teach similar lecture contents in the future. The
instructors can investigate their time to prepare to deliver the lecture contents rather than to create the lecture contents.
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PART ONE. AUTOCAD

Chapter 1. Introduction of AutoCAD

+ What is the application & 4 different AutoCAD

+ How to install the application

+ Understand AutoCAD interface — Ribbon, Panels, Model space, Layout tabs, Status bar, € Properties
» AutoCAD setup tips — Options, Unites, Workspace

+ Types and structure of drawings in Auto CAD- Floor plan, RCP, Elevation, Section, € Details

+ Input commands and understand different selections

+ Understand basic drawing tools— Origin, Line, Move, Rotate, Copy

+ Attach image/PDF/CAD and Adjust the scale

+ Set the project folder, Save the file, and backups

Chapter 2. Draw Floor Plans

+ Understand Layers — Name, Line type, Thickness, ¢ Color

+ Draw centerlines — Line, Ortho, € Offest

+ Draw exterior/interior walls, floor, millwork & openings — Polyline, Spline, Circle, Rectecgul, Object Snap, Mirror, Fillet,
Trim, Extend, Array, € Match Properties

Chapter 3. Create Dimensions and Components

+ Add/Edit dimensions (in model space)— Dim, € Dimension style
+ Add/Edit blocks from AutoCAD Tool Palette & Other sources — Door, Window, Column, Plumbing, Furniture &
Equipment

+ Create custom blocks — Custom furniture

Chapter 4. Draw Elevations and Sections

» Draw asection
+ Draw an elevation from Floor plan
+ Add/Edit Text & Annotation (in model space) — MText, Text style, M leader, €+ Multileader Style
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Chapter 5. Draw Ceiling Plans

+ Draw Ceiling Plans from Floor plan
+ Add/Edit Hatch

+ Create Legends

Chapter 6. Set Sheets

+ Understand the Model space and Paper spaces
+ Set a new layout — Page layout, €/ Plot styles
+ Set views in Paper spaces — Defpoints, Scaling

» Add/Edit/Draw a titleblock

Chapter 7. Symbols and prints

+ Add/Edit symbols in Paper spaces — drawing title, elevation symbol and section letters, north arrow
» Printing
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Chapter 1. Introduction of AutoCAD

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Understand what is the application & 4 different AutoCAD

(CO 2) Install the application on your computer

(CO 3) Understand the User Interface of AutoCAD — Ribbon, Panels, Model space, Layout tabs, Status bar, & Properties
(CO 4) Understand AutoCAD setup tips — Options, Units, Workspace

(CO 5) Understand the types and structure of drawings in Auto CAD- Floor plan, RCP, Elevation, Section, & Details
(CO 6) Input commands and understand different selections

(CO 7) Understand basic drawing tools- Origin, Rectangle

(CO 8) Attach image/PDF/CAD and adjust the scale

(CO 9) Set the project folder, Save the file, and backups

? Session Highlights

At the end of the session, students can create the graphics below.

CeARL ES
H midsls Pasmein Vs Manage  Outgt Addoen  Colshowts  Expamlsh Fedlusddgm G2
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[E:I Lecture Contents

(CO1) Understand what is the application & 4 different AutoCAD

A YouTube element has been excluded from this version of the text. You can view it online here: htips_.//iastate pressbooks pub/

visualgraphiccomm/?p=5

About CAD

Computer-Aided Design(CAD) or Computer-Aided Design and Drafting (CADD) can be defined as using computer systems
to assist in the creation, modification, analysis, or optimization of a design. (Narayan, 2008)

CAD software is used to increase the productivity of the designer, improve the quality of design, improve communications
through documentation, and create a database for manufacturing. (Narayan, 2008)

[ AutoCAD

|| File Edtt View Inset Format Took Draw Dimension

Dieial Slal¥| % | Dig] ol B i

Elallloasmo =] [ ByLaper

ORTHO PAPER

image credit: Shaan Hurley, AutoCAD R14 Welcome Sample DWG, Flicker
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CAD is an important industrial art extensively used in many applications, including automotive, shipbuilding, and aerospace
industries, industrial and architectural design, prosthetics, and many more. (Pottmann, and et al., 2007)

About AutoCAD

AutoCAD is an industry-leading commercial CAD software.

AutoCAD is used by AEC(Architecture, Engineer, and Construction) to generate and optimize 2D and 3D designs. AutoCAD
is a widely used software program that can help you draft construction documentation, explore design ideas, visualize
concepts through photorealistic renderings, and simulate how a design performs in the real world. (Autodesk)

AutoCAD was first released in December 1982 as a desktop app. In 2010, AutoCAD was released as a mobile- and web app,
marketed as AutoCAD 360. (Autodesk and AutoCAD)

Four AutoCAD products for AEC

+ AutoCAD: the original version of AutoCAD. This version can use architects, project managers, engineers, graphic
designers, city planners, and other professionals.

« AutoCAD Architecture: a version of Autodesk’s flagship product, AutoCAD, with tools and functions specially suited
to architecture work. This software supports dynamic elements (wall, door, windows, and other architectural
elements) and automatically updating Spaces and Areas for calculations of sqft.

« AutoCAD LT: the lower-cost version of AutoCAD, with reduced capabilities (No 3D, No Network Licensing, No
management tools, and more).

« AutoCAD 360: an account-based mobile and web application enabling registered users to view, edit, and share
AutoCAD files via a mobile device and web using a limited AutoCAD feature set and using cloud-stored drawing files.

(CO2) How to install the application

A YouTube element has been excluded from this version of the text. You can view it online here: htips_//iastate pressbooks pub/

visualgraphiccomm/?p=5

Install AutoCAD

This version is for educational purposes only.

You must know your system requirement first before you install the application. If you do not know your system use, please
find the information here.

« [STEP 01] Go to https://www.autodesk.com/education/free-software/autocad on your Windows side, open a web
browser (Chrome is recommended because the instructor tested).

« [STEP 02] Click [CREATE ACCOUNT] if you do not have one. If you already have an Autodesk account, please sign in
by clicking [SIGN IN].

7 | AutoCAD Session 1



[STEP 03] Select an appropriate version of AutoCAD, your system, and language.

« [STEP 04] Click [INSTALL).
[STEP 05] Accept the license and services agreement.

« [STEP 06) You will receive an email from Autodesk for the license information (Product key and Serial Number). It
will be needed for the activation process.

» [STEP 07] Click the downloaded installation file to install. The installation will take a while.

« [STEP 08] After installation, the software will require activation. Please use the license information.

(CO3) Understand AutoCAD interface — Ribbon, Panels, Model space, Layout
tabs, Status bar, & Properties

A YouTube element has been excluded from this version of the text. You can view it online here: htips_.//iastate pressbooks pub/
visualgraphiccomm/?p=5

Once you open AutoCAD by double-clicking the AutoCAD icon, you can create a new drawing by clicking the [START
DRAWING] icon on the first page of the AutoCAD application.

Recent Documents

180618 _Three IFC_48 40F

June 2020: Have you
tried to customize the
AutoCAD User Interface

1o better suit the way

Manage and Customzes Your
: Workspace
Start Drawing -

¥

CAD source-6262-convay301 Sign In to your Account
: Access online services

Send Feedback
Help us imprave our products

Send Feedhack

LEARN CREATE B

You also can select a different template by clicking [TEMPLATES] under start drawing. The default setting is [acad.dwt]

Your recent documents will show in the middle of the first page. You also can click to open the recent documents.
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What'r New Getting Started Videos

Plot a Drawing Layout

il

AutoCAD New Features Overview
Convert 2D Objects to 3D

Objects

Create and Modify Meshes

Create and Modify Surfaces

CREATED

Learning Tips

For a more precise placement, attach
@ POF before importing it. You can
then use the ALIGN command to
onent and place the PDF,

Motz information.

Explore traming matenals an the
web to sharpen your skills or leamn
something new.

The Hitchhiber's Guide

Hitchhiker's AutoCAD Basics

I\ AUTODESK.
Autodetk AuloCAD Seraces &
Suppart

For the tutorial provided by Autodesk, you can click [LEARN]. I recommend you watch the Getting Started Videos.

Once you click [START DRAWING], you will see this user interface below. [please remember the names]

QUICK ACCESS TOOLBAR

THE RIBBON

DRAWING AREA /
GRAPHIC AREA

COMMEND BOX

’ LAYOUT TAB |

+ Application menu: New, open, save, import, export, print

+ Quick access toolbar: User can save tools that they often use

« Info Center: Ask a question, find out answers from Autodesk community
+ Ribbon: Main menus — Home, Insert, Annotate, View, Manage

« Ribbon tab

« Ribbon view: User can minimize and maximize the ribbon

9 | AutoCAD Session 1
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« File tab: Navigate files and create and open files

+ Drawing area/graphic area: Main drawing space

« View cube: User can change the view, top, front, 3D, or more

+ Navigation bar: Zoom in and out, pan, zoon to all, and more

« Command box: Can type commands and see the previous commands
« Layout tab: Can see model space and print spaces

« Status bar: Can set grid, snaps, scales, and more

Please see this detailed user interface that is provided by Autodesk

(CO4) AutoCAD setup tips — Options, Unites, Workspace

A YouTube element has been excluded from this version of the text. You can view it online here: htips_//iastate pressbooks pub/

visualgraphiccomm/?p=>5

Before you start your drafting, it is recommended to set your workspace and options as you wish. Take some time and
experiment with the settings, as shown below. You can change settings at any time.

Below are the instructor’s recommended setups based on more than 10-years of drafting experience.

OPTIONS

« [STEP 01] Click [APPLICATION MENU] and then Click [OPTIONS], or type [options] on the command box, and
Enter key

« [STEP 02] You will see the Option window

« [STEP 03] Click Display tab > Change Color theme from dark to light

« [STEP 04] Find Crosshair size on the Display tab > Change the value from 5 to 100
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A Options

[] Show Page Setu

2000 | Number of seconds to delay

and Save Plot and Publish System User Preferences Drafting 3D Modeling Selection Profiles

i <<Unnamed Profile>> 25 Cument drawing: Drawing1.dwg
Display resolution
S Arc and circle smoothness

S Segments in a polyline curve

[] Display scroll bars in drawing window = Finadiornt chjack mpoullmeis
[] Use lange buttons for Toolbars S = !
[4] Resize ribbon icons to standard sizes . [:l Coraa Epenuae
Show ToolTips Display perfformance

m Number of seconds before display [] Pan and zoom with raster & OLE

Show shortcut keys in ToolTips :E Highlight raster image frame only

Show extended ToolTips M 1 eply sold i

*& []Show text boundary frame only

[C] Draw true silhouettes for solids and sufaces

Show rollover Tool Tips
[] Display File Tabs
Colors... Fonts...
Layout elements Fade control
Display Layout and Model tabs Xref display
Display printable area E
Display paper background Inplace edit and annotative representations
Display paper shadow

p Manager for new layouts

Create viewport in new layouts

[ ok ]| cCancel || Mgy || Hebp

» [STEP 05] Find [Color
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A

Curment profil|
Fles  Di

Window

Colorth

[[] Disp
[Juse
Res|
Shol

Disp

Layout &
Disp
Disp
Disp
[]5ho
Crez

~

Context:

(20 model space ]

| Sheet / layout

| 3D parallel projection

| 3D perspective projection
[Block editor

| Command line

| Plot preview

1

Preview:

Interface element:

[Uniform badkground PN
| Crosshairs

| Viewport control

| Grid major lines

| Grid minor lines

| Grid axis lines

| Autotrack vector

| 2d Autosnap marker

| 3d Autosnap marker

| Dynamic dimension lines
|Rubber-band line

|Drafting tool tip

| Drafting tool tip contour

| Drafting tool tip background

| Control vertices hull v

Apply & Close

Un

Color:
W Black v

Restore current element
Restore current context

Restore all contexts

Restore dassic colors

Cancel Help

carnce Py Help

+ [STEP 06] Click the Draftingtab > Change the aperture size — make slightly smaller
« [STEP 07] Click the Selection tab and uncheck[allow the press and drag for lasso] > Click [OK] to close the option
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A Options

Current profile: <<Unnamed Profile>> 2§ Cument drawing: Drawing1.dwg
Files Display Open and Save Plot and Publish System User Preferences Drafting 3D Modeli-'nﬁles
Pickbox size Grip size
i i
Selection modes Grips _
Noun/verb selection Grip Colors...
[[] Use Shift to add to selection [ Show grips
Object grouping [[] Show grips within blocks
[[] Associative Hatch Show grip tios
Implied windowing S S s
Allow Cirl+cycling behavior

Show single grip on groups

| . [] Show bounding box on groups
Both - Automatic detection v
100 Object selection limit for display of arips
Object limit for Properties palette
Preview
Selection effect color: Selection preview
B Default v When a command ig active
When no command is active
Ribbon options M
Visual Effect Settings...
Contextual Tab States... _ Command preview
Property preview

o[ oo | [ i || e

UNITS

« [STEP 01] Click [APPLICATION MENU] > click [DRAWING UNITS] > click [UNITS] or, Type [units] on the
command box > Enter key
+ [STEP 02] Confirm the units are right for your project
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Below snap is an image of a typical setting for the Imperial system.

A ['-r.j,'.l:'u-g Units

Length Angle

Type: Type:

Architectural v, ' Decimal Degrees v |
trecon: | |- _
00 1/16" vi |0 v

[[] Clockwise

Insertion scale

U_nit_s tos scale hsertﬁd_co_rtegl:

\lches s I

Sample Output

112" 2" 0"

3"<450"

Lighting

_l_Jnils for specfying the intensity of lighting:

‘Irtemdjonal v

| OK | Cancel ||  Drection.. || Hep |
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Below snap is an image of a typical setting for the Metric system.

A Drawing Units X
Length Angle
Type: Type:
Decimal v Decimal Degrees v
Ergqision: _ _Prec%siog x
.ﬂ). W 0 v
[ Clockwise
Insertion scale
Units to scale inserted content:
| Mllimexets |
Sample Output
220
3<450
Lighting
Units for specifying the intensity of lighting:
Intemational v
[Cod | [ oo | [ 5

PROPERTIES

« [STEP 01] Click the small arrow under Properties on Home Ribbon to open the Properties panel

= ©@ | | Bylayer v
i.‘_:i_s e [

¥ = ——Bylayer
Match = il (
* Properties == — Bylayer -

Properties « O

« [STEP 02] Or press [Ctrl+1] on your keyboard to open the Properties panel
+ [STEP 03] Place the panel on your left side of the workspace
+ [STEP 04] Click [Layer Properties] on Home Ribbon to open Layer properties

Fad00
Layer e =, “5 T =% Make Current
Properties|<- &, £, % i Match Layer
Layers ~

« [STEP 05] Place the panel on your left side of the workspace and click the arrow to hide the panel

LAYER PROPERTIES MANAGER 8 X
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The interface after setting changes

_ﬂ TEHRD 85 : L5 wa- =oX
Hum ort rrciaks wamaine ™ r— g Adbin silaberate Exprenm Teal Fustiond Ape C

(CO;s) Types and structure of drawings in Auto CAD- Floor plan, RCP,

Elevation, Section, & Details

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/

visualgraphiccomm/?p=>5

Architects and Designers use AutoCAD in slightly different ways. It is different from firm to firm and depending on who
draws the drawing. Moreover, it depends on what phase of the design you are in.

Many design firms never use layout tabs. Some firms use AutoCAD only for Schematic Design purposes. Some designers use
this application for presentation purposes too.

However, in this course, we are targeting to use all essential functions to generate a Construction Document set.

Below is a typical — fundamental — Construction Document set for an interior design project

« Cover sheet + general project information
+ Floor plans

+ Furniture + Finish plans

+ Ceiling plans

« Elevations + Sections

+ Details

For detailed information about the types of drawings, please refer
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Kilmer, W. Otie, and Kilmer, Rosemary. Construction Drawings and Details / W. Otie Kilmer and Rosemary Kilmer. Third
ed. 2016. Print.

(CO6) Input commands and understand different selections

A YouTube element has been excluded from this version of the text. You can view it online here: https_//iastate pressbooks pub/
visualgraphiccomm/?p=5

To draw in AutoCAD, you must understand different types of command input

» Use icons on Ribbon (Basic level)
e.g. Click [Home] ribbon > Click [Text]

» Use the commands box (Moderate level)
e.g. Click [command box] > Type MULTILINETEXT > Enter key

+ Use Shortcuts (Advanced level) — Please practice to improve the speed of work and productivity.
e.g., Type [MT] on a keyboard (mouse can be located anywhere, it can be lower case) > Enter

Often use shortcuts by the instructor [please remember the list of shortcuts]

» [I] - line

« [pl] - polyline

» [mt] — multiline text
» [m] — move

+ [co] - copy

+ [ro] - rotate

+ [z] — zoom and [a] — all
» [b] - block

+ [s] — stretch

+ [x] - explode

+ [ex] — extend

+ [c] - circle

+ [re] — regen (refresh)
» [h] - hatch

» [o] — offset

+ F3 - osnap

« F8 - ortho

Detailed information can be found in this link https://www.autodesk.com/shortcuts/autocad

Three types of selections

one click - individual objects

+ window selection (blue) — drag/click from left-top to right bottom to select all objects that are enclosed in the selection
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rectangle.

Y

[% % Sespecify spmeite cone = [Fants Wslygon CPalygon [ :

« cross selection (green) — drag/click from right bottom to left to select all objects crossed by the selection rectangle.

LA L T L

I e T T —— T

Tip. To select multiple objects, just click one and another. No need to hold [shift] key or [ctrl]

Refer to this link for select object Information from this link

AutoCAD Session 1 | 18



(CO7) Understand essential drawing tools- Origin and Rectangle

A YouTube element has been excluded from this version of the text. You can view it online here: htips_.//iastate pressbooks pub/

visualgraphiccomm/?p=5

Understand the “origin” of the drawing

AutoCAD drawing area is on a real scale, which means the drawing scale is 1:1 scale. Moreover, the drawing area is
unlimited. You can draw the entire earth in the drawing. Furthermore, you can draw a small object, too. Designers often lose
the point/location that they want to draw in the drawing when you draw in a big drawing. Thus, designers use the drawing
origin (0,0,0) - ((x,y,2) for a 3D model) as the base point of the project. Usually, the origin of the drawing is the left-bottom
corner on the first floor (if it is a 3D model). In AutoCAD, we use only (0,0) — (xy).

To start your drawing, draw a building footprint or property line first.

[STEP 1] Click [Rectangle] on the Home Ribbon, or type [rec] and Enter
« [STEP 2] Specify the first point, type [0,0] and Enter

[STEP 3] Specify the next point. Any point on the right-top corner will be fine. It depends on the project size. For our
project, type [58'7",20'4"]
[STEP 4] Type [z] to zoom and type [a] and Enter

Line (command)

« [STEP 1] type [1] and Enter
« [STEP 2] specify the first point by clicking a point or typing [x,y]
« [STEP 3] specify the end point by clicking a point or typing [x,y] — absolute point, type [@x,y] — relative point
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» Please refer to this link for the line command

Move (command)

STEP 1] type [m] and Enter

STEP 2] select the object/objects that you want to move and Enter
STEP 3] specify the base point

STEP 4] specify the second point to move the object/objects

+ Please refer to this link for the move command

[
[
[
[

Copy (command)

+ [STEP1
« [STEP2

type [co] and Enter

select the object/objects that you want to copy and Enter

« [STEP 3] specify the base point

« [STEP 4] specify the second point to copy the object/objects

« [STEP 5] specify the third point or more to copy the object/objects if you have. If you want to stop, use ESC
« Please refer to this link for the copy command

« Please practice Line, Move, Copy, and Rotate commands

[ et i WYY

(COB8) Attach image/PDF/CAD and adjust the scale of the attached file

A YouTube element has been excluded from this version of the text. You can view it online here: https_//iastate pressbooks pub/
visualgraphiccomm/?p=5

Download a floor plan image (Eames House-House)

From this page, click [Eames_House_Floor_Plan_House.jpg] and mouse right-click to save the image file to your project
folder.

Your CAD file and JPG file MUST be in the same folder. Otherwise, you have to relink the file every time or set your link
relatively.

Insert the image file.

» [STEP 1] Click [Insert] on the ribbon tab
« [STEP 2] Click [Attach] on the Reference palette
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4

‘ﬂ'D%EB@@J' v v
Insert

Annotate  Parametric  View Manage Output A360 ExpressTools Fi

| Home
- _ \% < lH:] |_1—_| E’:gﬁf Underlay Layers
I’ - \I f—) &

]__J *Frames vary™ =
Insert Bdit = Create_ Define Manage Block | Attach | Clip Adjust ) !
Attribute Block  Attributes Attributes Editor

Snap to Underlays ON ~

Block = Block Definition = E” ¥
Start Crawing1™ +

PROPERTIES [(—1[Topl[2D Wireframe]

No selection - @ <+ %

« [STEP 3] Select [Eames_House_Floor_Plan_House.jpg] from your project folder > Click [open]
« [STEP 4] Click [OK] on the Attach Image window

Name: Eamez_Houss _Floor_Plan_House v Browse...
Praview Path type Scale
- /| Specify on-screen
Relative path v Specly

I | i L 1“_”‘_

i [ - _I-H s T Inzartion paint

T e Ly S B

o [41 Spacify an-screan Rotation

[ ] Specify on-screen

L}
]
]
=r
i — |
PR |
I3

Angle: ‘g

I~ 1=

Show Cietails

Help

+ [STEP 5] Click the origin point or type [0,0] and Enter

Adjust scale

« [STEP 1] Specify the scale factor [1] and Enter
« [STEP 2] Select the inserted image > Change the Fade value to [50] or lower that you can see the background
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&

1

- . ove |Show | Background | External
] 50 i Transparency |References

el |

Adjust Clij
Start Drawing1*
PROPERTIES
Raster Image
General

Color [ Bylayer
Layer 0
Linetype
Linetype scale 1.0000
Plot style ByColor
Li ight
Transparency Bylayer
Hyperink
Brightness 50
Contrast 50
Fade 50

| Geometry
Paosition X o
Position Y o
Position Z o
Rotation 0
Width "
Height 1i/16"
Scale 1,0000

» [STEP 3] Zoom in to the scale or a known dimension

« [STEP 4] Type [SC] and Enter for Scale change

+ [STEP 5] Click a base point > Type [r] and Enter > Click the base point > Click a second point that you know a
dimension (for this draw, you can use the scale bar) > Type the known dimension [1']

E RN 51 SCALE Specify reference length <1°-8">: Specify second paint:

Change the drawing order

+ [STEP 1] Click the inserted image
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« [STEP 2] Mouse right-click > Click [Draw Order] > Click [Send to Back]

Repeat ZOOM
Recent Input

Clipboard

Isolate

Eraze

Move

Copy Selection

Scale

Rotate

Draw Order 2, Bringto Front
Group ', Send to Back

Image (& Bring Above Objects

Add Selected [ Send Under Objects

Move the image to the building footprint

+ [STEP 1] Select the inserted image

+ [STEP 2] Type [m] to move and Enter

« [STEP 3] Click a base point > Click the target point to move

« Tip! Use Object snap [F3] to select the target point from the building footprint.
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(COg) Set the project folder, Save the file, and backups

A YouTube element has been excluded from this version of the text. You can view it online here: htips_//iastate pressbooks pub/

visualgraphiccomm/?p=5

Save the file

It is vital to save your file as early as possible. Moreover, save anytime, and the moment you think it is appropriate. I usually
save within 15 min (at least four times per hour).

« [STEP 01] Click [Application menu] > Click [Save]

« [STEP 02] Select a project folder on your hard drive, external hard drive, USB, Dropbox, or Onedrive
« [STEP 03] Recommended file type — AutoCAD 2007/LT2007 Drawing(*.dwg)

« [STEP 04] Recommended file name — Eames_House_Project_Firstname_Lastname_01.dwg

Tip! (.bak) file is a backup file. In the default setting, every 10 minutes, the file will be saved. To use the backup file, change
the file extension (.bak) to (.dwg)
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Chapter 2. Draw floor plans

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Understand Layers — Name, Line type, Thickness, & Color

(CO 2) Draw centerlines — Object snap, Line, Move, & Offest

(CO 3) Draw exterior/interior walls, floor, millwork & openings — Polyline, Spline, Circle, Rectengule, Object Snap, Mirror,
Fillet, Trim, Extend, Array, & Match Properties

‘¥’ Session Highlights

At the end of the session, students can create the graphics below.

MomliZD Wirsframe]
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E Lecture Contents

(CO 1) Understand Layers — Name, Line type, Thickness, & Color

visualgraphiccomm/?p=32

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/

The concept of layers in CAD

Architects and designers use layers in vector-based CAD software.

The concept of layers allows CAD information to be organized, facilitates the visual display of the information on a
computer screen, and allows the information to be efficiently converted to the conventional print media of drawings.

The efficient use of layers can reduce document preparation time and improve document coordination.

The American Institute of Architects and National Cad Standard published “AIA CAD Layer Guidelines.”

Using layers can make your drawings easier to control and interpret for both you and your team. For example, you can draw
your interior walls on one layer, and furniture on another using a different color. You can quickly turn off your furniture
layer on a floor plan and turn on the furniture layer on a furniture plan.

You can control layers from the Layer Property Manager.

7 =" N .
/ =) (

Line Polyline Circle Arc

Draw ~
Start Drawing1®
& LAYER PROPERTIES MANAGER

Current layer: 0
T m| B SS&S

/'-I_—l_

'%' Move O Rotate %; Trim = &

9% Copy A\ Mimor [ Fillet - |5

D.;_- Stretch E‘ Scale EE Amay =
Modify =

A [‘_" [~ Linear -
. Leader -
Text Dimension o~
* = Table

Annotation =

x Eames_House_Project_Yongyeon_Cho_02 X +

s A
£ AT
ra—

Layer

b 45
ropertie:

» fSta.. Name - On

o 0 "

Freeze

Tock  Plot  Color
o 8 [Jwhite

Linetype

Continu...

Lineweight  Tran,..

—— Default 0 =

N... Description

Each layer has a set of properties assigned to it.

« Name
»  Turn On/Off

d' 0 v

+ Freeze — Looks the same as turning on and off but uses less memory. Boost the speed of work.

» Lock

« Plot — It shows on your screen, but it will not print.
« Color - It is for working on the screen — easier to recognize the layers by color. Usually, prints in black and white.
« Line weight — Important to identify the hierarchy of the lines

+ Line type

+ Transparency — not often used
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+ Description — note for the layer

Create Layers for the project

« [STEP 01] Open the Layer Property Manager panel by clicking the [Layer Property] icon under the [Home] tab on the

[Layers] panel.
« [STEP 02] Click [New Layer] or Press [Alt+N] to add a new layer
: Current layer: 0 Search for layer Q,
« m | @ '_7 & & oo
Filters «  S.. Name « 0. F. L. P.. Color Linetype Lineweight Transp.. N. Description
=5 All 0 Q LFpf S [Jwh.. Continu.. —— Defs.. 0 =}
i3 All Used Layers ( )
+ [STEP 03] Rename the name of the layer by double-clicking the name of the layer to A-WALL
« [STEP 04] Update the color of the layer by clicking the color section to YELLOW
« [STEP 05] Update the line weight of the layer by clicking the Lineweight section to 0.5
+ [STEP 06] Repeat the [STEP 02] to [STEP 05] to create the listed Layers below.
' x Cearch £
yo | Current layer: S-GRID Search fol
w o m| H BSSH
» 5. Name -~ 0. F. L. P.. Color Linetype Lineweight Tra... N. Description
& 0 G gl & [ white Continuous Default 0 @,
& A-ANNO Q o © M cyan Continuous Default 0 =3
& A-ANNO-DIMS § Lol © M cyan Continuous Default 0 =
& A-ANNO-TEXT G e © M coyan Continuous Default 0 =
& A-ANNO-TTLB Q1 al © [ white Continuous m— (.60 rrim 0 =8
& A-CLNG I et =N o ] Continuous m— 0,30 mm 0o B
£ A-CLNG-PATT Qe @ Cantinuaus Default 0 =
& A-DETL Qe @ Continuous Default 0 B
£ A-DOOR i gh © M blue Continuous — (.30 MM 0 B
& A-FLOR QT e mao Continuous e 0,30 M 0 B
£ A-FLOR-FNSH Qe mo Continuous Default 0 e
£ A-FLOR-HRAL QTS s Continuous Default 0 c
& A-FLOR-OVHD Q Ltgf © M40 DASHED e 0,30 i 0 B
£ A-FLOR-STRS QS 4 Continuous e (0,30 MM 0 @
& A-GLAZ QTS me Continuous s (0,30 rITY 0 =8
&7 A-GLAZ-CURT QS [z Continuous Default 0 (o8
o7 ASWALL Qg @ O yellow Continuous e (0,50 mm 0 (=8
& |-CASE Qe © M 230 Continuous Default 0 =8
£7 |I-FURN QT e W2 Continuous Default 0 =8
e & P-FIXT G S Oeo Continuous Default 0 B
= & S-COLS T S O yellow Continuous e (040 111111 0 O
B o/ S-GRID QTS W0 CENTER Default 0 =8
w0 & S-LEVL Qe W CENTER Default 0 =8
=

Note 1. To update line type, click the line type that you want to update, and click [LOAD], and find the line type that you

want to use for a layer, and click [OK], click the loaded line type to apply, and click [OK] to apply.

Note 1A. Due to the scale issue, the line type will not show it correctly. To correct the line type scale, type [Its] on the

keyboard, and press the [Enter] key and enter [number]. For this project, try [10]
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Note 2. The name of the layer is based on AIA CAD layer guidelines, the instructor modified. If you need other layers, please
refer to the guideline.

Apply a layer to a model

[Method 1]

« [STEP 01] Fine a line/lines or an element/elements that you want to apply a layer
« [STEP 02] Select a layer that you want to apply to, then a layer of the element will be changed

danage Output Add-ins Collsborate ExpressTools  Featured Apps =

[Method 2]

« [STEP 01] Select a layer that you want to draw
+ [STEP 02] Draw a line/lines or an element/elements within the layer

[Method 3]
+ Use [MATCHPROP] command or [MA] — match the property to copy a layer style to another

Tip. I prefer to use this method to speed up the work — Draw lines with all layers with name on the side of the drawing,
and use match property command whenever it is needed. You can save time to find the layer and select the layer from the
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drop-down menu.

(CO 2) Draw centerlines-column grid — Object snap, Line, Move, & Offset

A YouTube element has been excluded from this version of the text. You can view it online here: htips_.//iastate pressbooks pub/
visualgraphiccomm/?p=32

Drawing a centerline can be the first step in drawing a floor plan. The drawing order depends on the phase of design and
who is drawing. However, setting centerlines can be easier to draw a floor plan rather than starting from scratch.

« [STEP 01] Select the right layer to draw column grids. Click [S-GRID] from the [Home] ribbon on the [Layers] tab
« [STEP 02] Make sure [othormode] and [osnap] is on

mooeL [H] i ~ L& ~ \ ~ [T~ J

OSNAP setting — to select a specific point of an element, it is recommended to use object snap [OSNAP]. To set up object
snap, mouse right click on the OSNAP icon on the Status bar and check the point that you would like to select while the
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object snap is on.

v ./ Endpoint

= / - Midpoint

vy lE“,l Center
[2] Geometric Center
v o Node
b Quadrant
U = Intersection
v —- Extension
&3 Insertion

v _L_ Perpendicular

") Tangent
4 Nearest
" Apparent Intersection
// Parallel

-

Object Snap Settings... |

@ MOUSE RIGHT CLICK =

MODEL

3
R IR N |

This image is the recommended object snap settings for 2D drafting, based on the instructor’s experience. Note. For more
information regarding OSNAP, please read this link about using Object Snapes.

+ [STEP 03] Select [Line] from [Home] ribbon on [Draw] tab ,or Type [1] and press [Enter] on the keyboard to draw lines
Click the base point [0,0] and mouse move to plan north, and type [25] and press [Enter] on the keyboard

' £ PROPERTIES

Line

General
Color
Layer.
Linetype
Linetype scale
Plat style
Lineweight
Transparency
Hyperlink
Thickness

3D Visualization
Material

Geometry
Start X
Start Y
SartZ
End X
End Y
EndZ
Dalta X
Delta ¥
Delta Z
Length
Angle

Layer Properties Manager

- @

B Bylayer

S-GRID

— = = Bylayer
1.0000

BylLayer
ByLayer

0

Bylayer

oo maooao
1 LH SS9

- —

« [STEP 04] Move the gridline to the center of the building base footprint.

Click [Move] icon
or, type [m] and press [Enter] key

from [Home] ribbon on [Draw] tab
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Click the midpoint of the selected line, and then click the midpoint of the building footprint

CLICK CLICK THE
THE MIDPOINTOF ==+t = MIDPOINT OF THE
ECTED LINE BASE BUILDING
FOOT PRINT
[

+ [STEP 05] To create vertical grid lines, it is recommended to use the [OFFSET] command.

Click [OFFSET] icon € from [HOME] ribbon on [DRAW] tab
or, type [o] and press [Enter] key
Type a specific number that you want to offset, for this project, enter 7'-4-3/4"
and then press [Enter] key,
and then click a point to the direction that you want to create the copied line,
if you use the same distance, you do not need to enter the number,
if you use a different distance, you must enter a specific number
+ [STEP 06] Repeat [STEP 03] to [STEP 05] for horizontal grid lines
« [STEP 07] Copy the first level grid lines, both vertical and horizontal, for the second level
To copy the lines, please use an even number (e.g., 28'-11” based on the base drawing)
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(CO 3) Draw exterior/interior walls, floor, millwork & openings — Polyline,
Spline, Circle, Rectangle, Mirror, Fillet, Trim, Extend, Array, & Match Properties

A YouTube element has been excluded from this version of the text. You can view it online here: https.//iastate pressbooks pub/

visualgraphiccomm/?p=32

Let’s draw the floor plans (no columns, no furniture, no windows, no doors, no patterns, no symbols, no plumbing, no
dimensions, no texts at this point) with the following commands
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image credit: Screen captured by the Author from the application

Make sure you use the commands below to control and easy selection
[ORTHO)] or [F8] key, [OSNAP] or [F3] key

If needed, you can turn on/off [grid] by press the [F7] key

Polyline(command) — this is for creating a connected line. Once you make an element (wall) with a polyline, the lines will be
connected. This connection is useful in controlling each element.

+ [STEP 01] Type [pl] on keyboard and press [Enter] key

« [STEP 02] Specify start point

« [STEP 03] Specify the next point.

+ [STEP 04-01] If you want to close the object, type [c] on the keyboard and press the [Enter] key
« [STEP 04-02] If you want to finish the object without closing the object, press the [ESC] key

« Please refer to this link for the polyline command

Pedit(command) — this used to convert line objects to a polyline

« [STEP 01] Type [pe] on keyboard and press [Enter] key

« [STEP 02] Specify an object to convert a polyline

« [STEP 03] Type [y] and press the [Enter] key to turn the objects into one object.

« [STEP 04] Select [Join]

« [STEP 05] Select all connected objects that you want to join as a polyline, and press [Enter] key, and press [Enter] key
one more time to finish the command

« Please refer to this link for the Pedit command

Explodes(command) — this is to convert a polyline or a block to line objects

« [STEP 01] Select an object (polyline or a block) to convert to line objects
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[STEP 02] Type [x] on the keyboard, and press [Enter] on the keyboard
Please refer to this link for the Explodes command

Spline(command) — may not be needed for the Eames House project, but you will need it for your project — These

commands for creating a connected curved line.

[STEP 01] Type [spl] on keyboard, and press [Enter] key
[STEP 02] Specify the first point

[STEP 03] Specify the next points

[STEP 04] Press [Enter] key to finish

Please refer to this link for the Spline command

Circle(command)

[STEP 01] Type [c] on keyboard, and press [Enter] key

[STEP 02] Specify a center point

[STEP 03] Specify a radius by typing a specific number of by clicking a specific point
Please refer to this link for the circle command

Rectangle(command)

[STEP 01] Type [rec] on keyboard, and press [Enter] key
[STEP 02] Specify a first corner point
[STEP 03] Specify another corner point

Please refer to this link for the Rectangle command

Mirror(command)

STEP 01
STEP 02

[ Type [mi] on keyboard, and press [Enter] key
[

[STEP 03

[

[

Select an object/objects, and press [Enter] key

[ e

Specify the first point of the mirror line

STEP 04] Specify the second point of the mirror line

STEP 05] Decide whether to erase the source objects or not, and press the [Enter] key to complete the command
Please refer to this link for the Mirror command

[

Fillet(command) — create a corner between two objects

[STEP 01] Type [f] on keyboard, and press [Enter] key

[STEP 02] Select the first object

[STEP 02-01] If you want to create a smooth corner, you can specify radius by type [r] and press [Enter] key, and type
[specific number] and press [Enter] key

the radius information will be stored, if you want to create a sharp corner, the R =0/

[STEP 03] Select the second object

Please refer to this link for the Fillet command

Trim(command)

« [STEP 01] Type [tr] on keyboard, and press [Enter] key
+ [STEP 02] Select cutting edges
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« [STEP 03] Select object(s) to trim, and press the [Enter] key to complete the command
» Please refer to this link for the Trim command

Extend(command)

« [STEP 01] Type [ex] on keyboard, and press [Enter] key

« [STEP 02] Select boundary object(s)

« [STEP 03] Select object(s) to extend, and press the [Enter] key to complete the command
+ Please refer to this link for the Extend command

Stretch(command)

« [STEP 01] Type [s] on keyboard, and press [Enter] key

« [STEP 02] Select objects — specify the portion of the object that you want to stretch, using the crossing object selection
method, and press [Enter] key

« [STEP 03] Specify the base point

« [STEP 04] Specify the destination point to complete the command

+ Please refer to this link for the Stretch command

Match Property(command)

« [STEP 01] Select source object
+ [STEP 02] Select destination object(s)

« Please refer to this link for the Match Property command

There is no right or wrong way to draw a floor plan, be creative, Designers!!
SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Chapter 3. Create dimensions and components

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Add/Edit dimensions (in model space) — Dim, & Dimension style

(CO 2) Add/Edit blocks from AutoCAD Tool Palette & Other sources — Door, Window, Column, Plumbing, Furniture &
Equipment

(CO 3) Create custom blocks — Custom furniture

‘¥ Session Highlights

At the end of the session, students can create the graphics below.
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E Lecture Contents

(CO 1) Add/Edit dimensions (in model space) — Dim, & Dimension style

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/

visualgraphiccomm/?p=78

Open your working CAD file.

Understand CAD dimension scale settings

« [METHOD 01] Dimension in model space for plotting in model space — This is the traditional method used with
single-view drawings — Need Text height charts for correct text height, and it is challenging to be flexible in drawing
scale.

« [METHOD 02] Dimension in model space for printing or plotting in paper space — This was the preferred method for

complex, multiple-view drawings. (We will practice this method for our project)
« [METHOD 03] dimension in layouts — This is the simplest dimensioning method
+ Please refer to this link for more information about scale for dimensions

Text Heights in paper space (1=1)

« 10 pt = 3/32" (minimum font to read)
« 12 pt=1/8"(Standard text size)

« 18 pt = 3/16" (Subtitle text size)

« 24 pt=1/4" (Title text size)

Understand the types of dimensions

« The basic types of dimensioning are linear, radial, angular, ordinate, and arc length.
« Please refer to this link for more information about the types of dimensions
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Before you add dimensions, move the inserted drawing image to avoid accidental deletes and confusion.

100’ MOVED TO RIGHT

Move the image to the right side — 100ft or any number that you can easily remember. You might need to move the image
back to the original position.
Note. Make sure you turn on [ortho]

Set Drawing scale

« Before you start to add dimensions, it is recommended to set the drawing scale. Sometimes, the drawing scale can be
changed for the drawing. However, once you set the drawing scale, less work is needed at the end.

+ The drawing scale is defined with some factors — the paper size, purposes of submissions, and so on.

« For this project, you will be asked to print out your drawings in 11in x 17in (Horizontal layout). Although the inserted
original drawing scale is 3/8" = 1 -0", your drawing scale should be 3/16" = 1’ -0”

« To set the scale, click the drawing scale [1:1] and select the drawing scale [3/16” = 1" -0]

image credit: Screen captured and modified by the Author from the application

« If you cannot find the ft-in types of scale, click [Custom] > click [Add] > add the name of the scale [3/16” = 1-0"], add
the value on Paper units [3/16], add the value on Drawing units [12] > click [OK] to complete the custom scale > click
[OK] to set the scale

Set Dimension style

“A dimension style is a named collection of dimension settings that control the appearance of dimensions, such as arrowhead
style, text location, and lateral tolerances.” (Autodesk help, Mar 29, 2020)

Please refer to this link for more information about dimension style

« [STEP 01] To open Dimension Style Manager,

click [Annotation] ribbon tab, click [ * /] on Dimension panel
or, type [ddim] and press [Enter] key

« [STEP 02] Click [Annotative] > Click [Set Current] > Click [Modify] to open Modify Dimension Style: Annotative
window
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X

A Dimension Style Manager

Curmrent dimension style: Annotative

Styles: Preview of : Annotative
f.y Annotative)
Slanaardg
List: Description
Annotative

[STEP 03] Click [Lines] tab

adjust the Baseline Spacing to 1/16”

adjust the Extend beyond dim lines to 1/16”
adjust the Offset from origin to 1/16"
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A Modify Dimension Style: Annotative X

Symbols and Amows  Text Fit Prmary Units Altemate Units Tolerances

Dimension lines

Color: [ ByBlock v

Linetype: ByBlock v

Lineweight: ——— ByBlock v

Extend beyond ticks: P =

Baseline spacing: l 116" S

Suppress: [] Dim line 1 [] Dim line 2

Extension lines

Color: L] ByBlock ¥| (Extend beyond dim lines: 1/16" =)
Linetype ext line 1: ByBlock v @ﬁset e — 3
Linetype ext line 2: ByBlock v

(] Fixed length extension lines
Lineweight: ——— ByBlock v
Length: 1 =
Suppress: [ Et line 1 []Ext line 2

Cancel Help

+ [STEP 04] Click [Symbols and Arrows] tab
adjust the first Arrowheads to / Architectural tick
adjust the second Arrowheads to / Architectural tick
adjust the arrow size to 1/8”
adjust the break size to 1/16”
adjust the Jog height factor to 1/16”
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A Modify Dimension Style: Annotative

Lines (Symbols and Arrowﬂ Text Fit
Amrowheads

First:

Prmary Units Altemate Units Tolerances

/" Architectural tick

Second:

(/ Architectural tick

Leader:
# Closed filled

Amow size:

Center marks

.

(®)iNone;

() Mark - -
O Line
Dimension Break

Break size:

Arc length symbol

(®) Preceding dimension text

() Above dimension text
() None

Radius jog dimension

Jog angle: [as

Linear jog dimension
Jog height factor:

(116" 2 ) Text heigrt

Cancel

Help

» [STEP 05] Click [Text] tab
adjust the text height to 1/8”
select Aligned with the dimension line

AutoCAD Session 3 | 42



A Modify Dimension Style: Annotative

Lines  Symbols and Amows

Text appearance

[] Draw frame around text

Text placement

Vertical: Centered
Horizontal: Cerfered
View Direction: Leftto-Right

Text style: Standard v
Text color: [ ByBlock

Fill color: [J None

Text height: 1/8"
Fraction height scale: | 1.0000 =

Offset from dim line: 1/8"

Prmary Units Altemate Units Tolerances

Text alignment

(7) Horizontal

(éﬁl Aligned with dimension ]ine)

(O 150 standard

Cancel Help

« [STEP 06] Click [Fit] tab
make sure [Annotative] is checked
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A Modify Dimension Style: Annotative X

Llines  Symbols and Amows Text Prmary Units Altemate Units Tolerances

Fit options

If there isn't encugh room to place both text and
amows inside extension lines, the first thing to
move outside the extension lines is:

(®) Either text or amows (best fit)

() Arows

O Text

() Both text and amows

(O Always keep text between ext lines

Scale for dimension features

[] Suppress amows if they dont fit inside .
extension lines [ Annotative ]

Text placement

o

When text is not in the default position, place it:

(@ Beside the dimension line Fine tuning
(O Over dimension line, with leader [ Place text manually
O Over dimension line, without leader ] Draw dim line between ext lines

Cancel Help

[STEP 07] Click [Primary Units]
adjust the Unit format to Architectural
adjust the Precision to 0" -0 1/8"
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A Modify Dimension Style: Annotative X
Llines  Symbols and Amows Text Fit emate Units Tolerances
Linear dimensions
Unit format: Architectural
Precision
Fraction format: Horizontal
Decimal separator: (Period
Bound off: | 0"
Prefix: ‘
Suffix: l
Measurement scale
Scale factor: ‘ 1.0000 :
[] Apply to layout dimensions only Angular dimensions
Zero suppression Units format: Decimal Degrees v
Sub-units factor: Ofect Precision: 0 v
i w2 Zero suppression
10
Sub-unit suffix: Oinches [] Leading
[] Trailing
Cancel Help

+ [STEP 08] Click [OK] to complete the modification > Click [Close] to finish the dimension style manager

Add dimensions

+ [STEP 01] Change layer to [A-ANNO-DIMS]

E:

Q o [ A-ANNO-DIMS

% “p £Z Make Current

b=
Lyey ¥ % % -
Properties £y &, £5 <4 &5 Match Layer
Layers =

« [STEP 02] Click [Annotate] ribbon tab > make sure the dimension style is [Annotative] > click [Linear] to draw

dimensions
or, type [dim] and press [Enter]
If Linear doesn't fit for your purpose, please select the types of dimension that you want to add.
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w Home Insert ((Znnotate ) Parametric  View  Manage Output  A360  Express Tools  Featured Apps  Acrobat D=

A TE= d A S0 7| o |

Thickness
3D Visualization

Material

Extarnal Referances

« [STEP 03] make sure you turn on Object Snap
Click the intersection point at the top left corner of the building column grids
Click the next intersection point for dimensioning
Click a third time to place the dimension line and text

{41 Continue ~
« [STEP 04] if the dimensions are in a continuous string, please use [continue] from the [Annotation]

tab, [Dimensions] panel.
Add additional dimension lines to the previous dimension.
« [STEP 05] Repeat to dimension all column grids for the first floor and overall building dimensions.
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Add a new dimension style

— 3/32" text size — Annotative and interior wall dimensions.

STEP 01] Type [ddim], and press [Enter] key to open [Dimension Style Manager]
STEP 02] Click [New] to create a new dimension style
STEP 03] Add new style name [Annotative 3-32], check start with [Annotative], [Annotative] checked, and click
Continue]
+ [STEP 04] Adjust Arrow size from Symbols and Arrows to 1/8",
adjust Text height from Text to 3/32"
click [OK], click [Set Current] and click [Close]
« [STEP 05] Make sure your layer is correct in [A-ANNO-DIMS]
« [STEP 06] Type [dim], and press [Enter] key and start dimensioning for the interior walls (You don't need to match

-
—_— —

your dimensions exactly, as reference for this project, +/- 4 inches are acceptable)

(CO 2) Add/Edit blocks from AutoCAD Tool Palette & Other sources — Door,
Window, Column, Plumbing, Furniture & Equipment

A YouTube element has been excluded from this version of the text. You can view it online here: htips_.//iastate pressbooks pub/

visualgraphiccomm/?p=78
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Understanding the concept of blocks in AutoCAD

+ Ablock is a collection of objects that are combined into a single named object.

+ Although a block and a group in AutoCAD look similar, these are different concepts.
Basically, blocks are copies that will change if you change one, but groups will not change. Groups are unique.

+ Ablock consists of the name of the block, the block geometry, the location of the base point, and any associated
attribute data.

« For more information about blocks, please refer to this page

Source of blocks

Designers/drafters often bring blocks from outside resources. They use free resources from other websites and/or resources
from the firm for schematic design to save time, resources from manufacturers for design development, and/or construction
documents.

AutoCAD provides some basic blocks. You can find the block from the [Content Browser] and add blocks to [Tool Palette]
and [Design Center]

Cad library websites

« BIM object - https://www.bimobject.com/en-us
» CAD blocks - https://cad-blocks.net/index.html
» DWG models — https://dwgmodels.com/interiors/

Furniture manufactures websites for the Cad library

» Knoll - https://www.knoll.com/design-plan/resources/furniture-symbols

» HermanMiller — https://www.hermanmiller.com/resources/3d-models-and-planning-tools/product-models/

» Steelcase — https://www.steelcase.com/resources/3d-models-cad/

« AllSteel — https://cms.allsteeloffice.com/Pages/Design-Resources/Planning-Tools/Planning ToolsLandingPage.aspx

If designers/drafters cannot find blocks that they want to use for the project, they can create custom blocks. Sometimes it
saves more time.

Add blocks from Tool Palettes (Use basic blocks from AutoCAD library)

Move the linked Eames House Floor plan image to match the drawing for reference— We moved the image to 100ft to the
right. At this time, move the image back to the original place. If the image is hidden, show the image by clicking [Show Image]
on the Image ribbon. If the image hides your drawing (Cad objects), let’s change the drawing order by mouse right-click on
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the image and click [Draw Order] > click [Send to Back]

Repeat EXECUTETOOL
Recent Input

Clipboard
Isolate

Erase

Move

Copy Selection

Scale

Rotate

Draw Order ))'% Bring to Front
Group > @ Sm&mhei

Image > I3y Bring Above Objects
[y Send Under Objects

Add Selected

Select Similar

We will add columns from the tool palettes.

+ [STEP 01] Click [View] tab > Click [Tool Palettes] under Palettes panel to open the panel or, type [TOOLPALETTES]
on the command, and press [Enter] key
Once the tool palettes are open, place the palette in a comfortable location (I personally like all palettes on the left side
of the application.

« [STEP 02] Click [Structure] tab on the tool palettes > Click [WF beam — Imperial]

+ [STEP 03] Change the layer to [S-COLS]

+ [STEP 04] Place the column on the top-left corner of the building. At this time, you cannot place the [WF beam —
imperial] to the precise location.
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« [STEP 05] Move the column to the right position using [osnap] and guidelines

« [STEP 06] Copy the column to other positions of the first-floor plan; you will need to rotate the drawing and adjust
your drawing according to the column locations.
Tips. Use the intersection with object snap [F3] and ortho tool [F8]

+ [STEP 07] Copy the columns on the first floor to the second floor.
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You may lock the layers that do not need to be selected. After you copy the columns on the first floor to the second

floor, you may also unlock the layer you locked.
. . " ot = : =0 af0o I

F . —
. L & I

Eames House Project_Vongyeon_Cha 03 +

Tansp... Plet

Edit a Dynamic block

You can find [Door-Imperial] and [Window-Imperial] from the Architecture tab on the tool palettes to add to your drawing.
However, the currently loaded blocks (ex. [Door-Imperial] and [Window-Imperial] with a thunderbolt image) on the tool
palettes are called [Dynamic block], a dynamic block is a parametric block that users can easily modify.

STEP 01] Click [Window — imperial] on the tool palette

STEP 02] Place [Window — imperial] block in your drawing

STEP 03] Double-click [Window — imperial] to open Edit Block Definition
STEP 04] Click [OK] to open the Block Editor

—_—— — —

51 | AutoCAD Session 3



A Edit Block Definition

Block to create or edit
- Preview
[ndowimper I

<Cument Drawing>
_ArchTick

Door - Impenial

Door - Left Hung 36in.
Drawing Title - Imperial
| Beam - Imperial
Staircase - Spiral

WF Beam - IEerial

+ [STEP 05] Select [Width=3"-0"] and adjust [Dist type] to [Increment] on the properties palette. And adjust [Dist
increment] to [1/47]

PROPERTIES

Harizontsl Constraint Faameter L@ 4

i

~ Caler. W Eylaye
Layer o
Linetype
Linetype scale 1.0000
Plat style ByCalar
Lineweight
Transparency Hyleyer

Canatr. | Modei

| Cid | ihectricsl | Macha . | Archite.. | Annot

i

o | hmadern |Cormn, | Tubles | Mustche .| Struc

L PALETTES

[STEP 06] Select [Wall=0"-4"] and adjust [Dist type] to [Increment] on the properties palette
[STEP 07] Click [Save Block] from the [Block Editor] ribbon

[STEP 08] Click [Close Block Editor] to close

[STEP 09] Relocate the window and update the size of the window according to the floor plan
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Repeat the steps for [Door-Imperial]. You will need to change the [Dist type] for [Door Size] and [Wall Thickness]

Complete placing and adjusting windows (curtain walls) and door (interior and exterior doors) within correct layers. If you

can find the blocks, you can draw the elements with [line] or [poly line]

Add more blocks using [Design Center]

Design Center is a tool to access and add blocks, Dimension styles, Layers, Layouts, Line types, Multi leaders, Table styles,
Visual styles, and Xrefs.

For more information about the Design Center, please refer to this page

I am going to demonstrate how to load a sink from the AutoCAD sample blocks.

« [STEP 01] Change layer to [P-FIXT]

« [STEP 02] Click [View] tab > Click [Design Center] icon |
or, Type [adcenter] on the command line, and press [Enter] key to open the Design Center window
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[STEP 03] Once you click the [Home] icon , you can find [en-us] folder > double-click to open [en-us] > double-
click to open [Design Center]. You can find some sample drawings containing blocks

The folder structure may be different from the versions of AutoCAD, but generally, you can find the sample CAD files
C:\Program Files\Autodesk\AutoCAD 2020\Sample'en-us\DesignCenter

[STEP 04] Double-click [Kitchens.dwg] > Double-click [Blocks] > Double-click [Sink-single-30 in top] to inset in your
file > Click [OK] to confirm the information

[STEP 05] Place the sink in the kitchen, using object snap

- Dual

O m =

Range-Oven Range-Owven Range Hood
-30infront  -30intop - 30infront

I O e
;nura- 3G in.., ;nnr -36 .. '- !:i:n tc:a
= (| m

ﬁnk‘-sin‘gl:- Wall Cabinet Wall Cabinet
Ointop  -1Bx2in.. -18x3bin. w|

DesignCenter Kitchen example

[STEP 6] Click the inserted block [Sink-single-30 in top] > Mouse right-click > Click [Edit Block In-place] > Click [OK]
on reference Edit

[STEP 7] Use [Stretch] tool to resize the sink, and delete elements that are not needed, and add geometrics for the sink
Note 1. For the assignment, you don't need to make the model 100% the same. Some flexibility will be acceptable
(shape of sink and faucet)

Note 2. When you draw a new line and element, use the [0] layer in a block

[STEP 8] Once you are done with the editing > Click [Save Changes] on the [Home] ribbon, under [Edit Reference]
panel
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If you want to rename the block, type [rename] on the commend. > Click [blocks] > Click [blocks that you want to rename]
If the block is your own or whether it was modified from another or created new, add [000_] in the first part of the block
name to recognize/find the block easily

ltems

_ArchTick
“ClosedBlank

Door - Imperial

Door - Left Hung 36in.
Drawing Title - Imperial
| Beam - Impernial
Sink-double - 36 in top

Sink-single - 30 in top

If you want to use a downloaded CAD file (e.g,., https://cad-blocks.net/kitchen-cad-blocks-kitchen-sink.html ).

+ Save the downloaded file in a project folder

+ Open the [design center]

« Click [Load]

+ Find the project folder where you saved the downloaded cad file

+ Click [Open] to load

« Double-click [Blocks]

+ Select a block that you want to use in your project and double click to load

If the inserted block is the wrong scale, adjust the scale.
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Please use these strategies to draw plumbing fixtures in the kitchen and bathrooms.
You will select your selections of blocks. The below image is a reference only.

+ Add (2) beds in the bedrooms

+ Add (1) desk and chair set in the bedroom

+ Add (1) dining table-chair set in the dining area
« Add (1) table in the alcove

« Add (1) table in the living room

+ Add bookshelves in the living room

« Add (1) lounge chair in the living room

+ Add (2) chairs in the living room

We will ask you to create custom furniture (sofa set) below.

(CO 3) Create custom blocks — Custom furniture

A YouTube element has been excluded from this version of the text. You can view it online here: htips_//iastate pressbooks pub/

visualgraphiccomm/?p=78

Sometimes, you may experience difficulty finding CAD blocks from CAD library websites and/or manufacturers’ websites.
Especially, it is hard to find furniture blocks for residential projects. In this tutorial, you will learn how to create blocks using
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product information and photos. I will demonstrate it using two different sofa sizes from the website Design Within Reach
(DWR). You will create using your selections of furniture for the project.

Create an 86" sofa block

« [STEP 01] Retrieve the product information (dimensions) and images from the DWR website

« [STEP 02] Change layer to [0] > Draw overall size of the sofa (Width=86" & Depth=33") using [pline] or [rectang], make
sure turn [ortho] on for 90 degree

« [STEP 03] Download or screenshot the product image to your project folder
Most of the time, you cannot find a top view of a product. You may rely on a front view to draw a floor plan view for
the product.

+ [STEP 04] Insert the front view image into your drawing file. Click [Insert] tab > Click [Attach] > Click the downloaded
file > Click [Open] > Click [OK] on Attach Image > Click once on the drawing area > Click once again near the first
point > Click the inserted image > Adjust the [Fade] value to [50] > mouse right-click on the image > Click [Drawing
Order] > Click [Send to back]

« [STEP 05] Relocate and rescale the inserted image to match the overall sofa dimensions.

For relocating, you will need to use [Move], [Rotate], and [osnap] command.
For rescaling, you will need to use [scale] with Reference [R].

« [STEP 06] Draw the details of the sofa using [line], [pline], [rectang], and [circle]. Use the detailed dimensions what the
website provided. Also verify the dimensions using [distance] — type [di] and press [Enter] key

+ [STEP 07] Before defining the lines to a block, make sure all lines are in the [0] layer.

« [STEP 08] Select all lines for the sofa (excluding the inserted image) > Type [b] on the command line and press [Enter].
Block Definition window will open > Name the block something meaningful (e.g., 000_DWR-Bantam_Sofa-Plan) >
Click [OK] > Change the block from [0] layer to [[-FURN] > If you don’t need the inserted image anymore, you can

delete the image.

Create a 73" sofa block using the [ooo . DWR-Bantam Sofa-Plan] block

Rather than redraw the 73" sofa block from scratch, you can start with the [000_DWR-Bantam_Sofa-Plan] block and using
the Stretch tool to adjust the length.

« [STEP 01] Type [co] to copy [000_DWR-Bantam_Sofa-Plan] block or Insert the [000_DWR-Bantam_Sofa-Plan] block
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on the drawing area — Click [Insert] tab > Click [insert] icon under Block panel > Select the block > place the block on
the drawing area.

« [STEP 02] Type [x], and press [Enter] key. The Explode command breaks up a block into individual lines. This
commend is useful to convert a block into elements for redefining a block.

For more information about this command, refer to this page.

» [STEP 03] Use [Stretch] commend to resize the sofa. And edit the details.

« [STEP 04] Create a new block by typing [b], and pressing [Enter] > name the block [000_DWR-Bantam_Sofa-73-Front]
> update the layer to [I-FURN] > place the sofa

SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)

:.j: References

Text and Scale Factors. (n.d.). Retrieved October 19, 2020, from http://cstl-ptisemo.edu/bbowers/files/
text%20and%20scale%20factors.pdf

Autodesk Help. (2018, January 11). About Setting the Scale for Dimensions. Retrieved October 19, 2020, from
https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2018/ENU/AutoCAD-
Core/files/GUID-30D6D9C8-AB99-47D1-B420-3D4EB6C7B0D 1 -htm.html

Autodesk Help. (2018, January 11). About the Types of Dimensions. Retrieved October 19, 2020, from
https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2018/ENU/AutoCAD-
Core/files/GUID-9A8AB1F2-4754-444C-B90D-CD3F2FC8A3E0-htm.html

Autodesk.Help. (2020, March 29). About Dimension Styles. Retrieved October 19, 2020, from
https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/AutoCAD-
Core/files/GUID-5469B348-3425-41C6-9CEC-F267BE6CCCA2-htm.html

AutoCAD Session 3 | 58



Autodesk.Help. (2020, March 29). Blocks. Retrieved October 19, 2020, from https://knowledge.autodesk.com/support/
autocad/getting-started/caas/CloudHelp/cloudhelp/2019/ENU/AutoCAD-Core/files/
GUID-2DA2ADA1-C8CC-4E61-9598-06580FFD 3544-htm.html

Autodesk.Help. (2020, March  29). About DesignCenter.  Retrieved  October 19, 2020, from
https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/AutoCAD-
Core/files/GUID-B307 1AE7-76BB-436C-9BAE-CC54CFBD4F96-htm.html

Design Within Reach. (n.d.). Retrieved October 19, 2020, from https://www.dwr.com/living-sofas-sectionals/bantam-sofa/
1246.htmlzlang=en US#lang=en US&q=bantam&start=2

Autodesk.Help. (2020, March  29). Explode (Command). Retrieved October 19, 2020, from
https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/AutoCAD-
Core/files/GUID-E98BCEF4-DED6-48A6-87EB-10FE87188083-htm.html

59 | AutoCAD Session 3



Chapter 4. Draw elevation and sections

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Draw a section
(CO 2) Draw an elevation from the floor plan
(CO 3) Add/Edit Text & Annotation (in model space-annotative) — M Text, Text Style, M leader, and Multileader Style

' Session Highlights

At the end of the session, students can create the graphics below.
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E Lecture Contents

(CO 1) Draw a section

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/
visualgraphiccomm/?p=80

“A section is a cut-through of a space that will show more of the room'’s features. It also allows you to show some structural
detail. A section line can be cut from any part of the space, depending on what you would like to show.”
Retrieved from https://www.nda.ac.uk/blog/identify-plans-elevations-sections/

“A ‘section drawing, ‘section,’ or ‘sectional drawing’ shows a view of a structure as though it had been sliced in half or cut
along another imaginary plane.”

Retrieved from https://www.designingbuildings.co.uk/wiki/Section_drawin

For more information about a building section drawing, please read this page: h
Section_drawing

In this tutorial, students will draw a building section based on Eames House, House, Section A-A’ drawing, the plan south
section (You can download the image from Canvas Module and this link Eames_House_House_Section_A-A’jpg), and your
space planning (Furnishings, fixtures, and equipment).

I I

=

¥
“‘-_
‘ ‘ = .

N

image credit: Screen captured by the Author from http://www.loc.gov/pictures/collection/hh/item/ca4169/ (Eames House
as-built drawing, public domain)

+ [STEP 01] Open your CAD file for the Eames House Project.
« [STEP 02] Copy the floor plans (1st floor & 2nd floor) to the right side 100". This step is optional, but I prefer to save
the original plans and to use the copied plans for creating a section view.
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specify second peint or [Array] cuse first peint ax dli:\u_'mm\

Madded '

« [STEP 03] confirm you are in [0] layer and Draw a section line (recommended to use [PLINE]) on the first floor for a
section view. Copy the section line in the same position for the second floor. You can rely on a column grid line. (For
section line, you can break and offset the line to focus on key interior and/or architectural elements. The line should
start and stop outside of the plan, and you should add a small perpendicular box to indicate the direction of the section
view. Update the section lines to the [A-ANNO)] layer.

+ [STEP 4] Draw a perpendicular line from the section line on the first floor to indicate the building boundary and
drawing boundary.
+ [STEP 5] Insert the section drawing (Eames_House_House_Section_A-A’jpg) by clicking [inset] > click [attach] > select

the file Eames _House_House_Section A-A’jpg from your project folder > click [open] > click [ok] on Attach Image

window > click a base point and the second point to insert the image > adjust Image Fade to 50 > mouse right-click on
the image > click [Draw Order] > click [Send to Back]
+ [STEP 6] Relocate (use [move] command) and rescale (use [scale] command) the inserted image to fit the building
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boundary for the section lines.

Note, you must use the object snape [F3] appropriately when you adjust the scale. Sometimes the object snap works
perfectly to click the CAD object. Sometimes the command does not work to click a point in a raster image.

[STEP 7] Now, you are ready to draw the section with the inserted image.

= Note 1. You will rely on the dimensions on the inserted image, the lines on your floor plan. Use numeric values to
draw lines (please, don't just click on the image except for the spiral stair. The image is reference only because the
scaled image is always a bit off).

= Note 2. Create three new layers

= [A-LWT-OBJECT] 0.2mm — The edges of objects, and represent a change in depth
= [A-LWT-SECTION] 0.5mm — The lines are representing the boundary of anything cut-through
= [A-LWT-SURFACE] 0.05mm — The lines are detail lines on an object. They don't represent much (if any)
change in depth
> Note 3. Use [LINE]. [PLINE], [SPLINE], [CIRCLE], [TRIM], [OFFSET], [FILLET], [EXTEND], and [STRETCH]
commands.
 Note 4. You also update the line type manually for door and window openings.
> Note 5. First, you draw the guidelines. You are using [xline] for creating a line of infinite length.
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> Then, you draw the section lines.

o After that, you draw the object lines.

= Draw surface lines for details.
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+ [STEP 8] Move the section and the section lines that you drew except the inserted image 100’ to the left to save the
section drawing in a safe drawing area.

« [STEP 9] Create a block for the section. Select all the elements in the section > Type [B] for creating a block > Define
the name [000_Section A-A’] > Click [OK]

(CO 2) Draw an elevation from the floor plan

A YouTube element has been excluded from this version of the text. You can view it online here: https.//iastate pressbooks pub/

visualgraphiccomm/?p=80

“An elevation is a view from the side of an object when drawing interior elevations; this would represent one of the walls.
This would include any windows or doors as well as any built-in furniture that is in direct contact with the wall”
Retrieved from https://www.nda.ac.uk/blog/identify-plans-elevations-sections/

“The term ‘elevation’ refers to an orthographic projection of the exterior (or sometimes the interior) faces of a building, that
is, a two-dimensional drawing of the building’s fagades.”

Retrieved from https://www.designingbuildings.co.uk/wiki/Elevations

In this tutorial, students will draw an interior elevation based on Eames House, House, Section C-C’ drawing, the plan west
elevation in the living room. Students will not draw a section. You will need to understand the concept of elevation and will
draw only interior elevation.
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» [STEP 01] Decide an elevation view.

+ [STEP 02] Draw outline of the elevation by using [xline] to draw the boundary of the elevation.
« [STEP 03] Rotate and relocate the section view c-c’ from the inserted image to match the boundary of the elevation.
You will need to rotate 90degree clockwise.

« [STEP 04] Rotate the copied floor plan and the inserted image to 90degree counterclockwise. The reason for this step
is to draw the elevation quickly. It typically takes less time to draw the elevation in the right direction (Up-North,
Down-South, Left-West, and Right-East).

+ [STEP 05] Remove the elements that are not needed from the copied floor plan. Make sure you saved the original floor
plan. You only delete the elements in the COPIED floor plan.
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+ [STEP 06] Now you can draw the elevation

= Draw floor level and ceiling level (8’ -1” AFF) (Typically, an interior elevation expresses interior elements only.
You don't draw wall thickness, window cut, ceiling structure, and roof structure.) > Change the lines for the wall
ends, floor level, and the ceiling level to [A-LWT-SECTION]
o Switch the layer to [A-LWT-OBJECT] > Draw wall and furniture by using [LINE], [PLINE], [CIRCLE], [FILLET].
[TRIM]
o If needed, switch the layer to [A-LWT-SURFACE] > Draw anything that is not important in terms of construction.
« [STEP 07] Add dimensions and opening for more information

= On the Application Status Bar, switch the scale to 3/8” = 1’0"
> Type [ddim] and press [enter] to open [Dimension Style Manger]
= Click [Annotative-3-32] > click [Set Current] > click [Close]
> Type [dim] and press [enter] to add dimension
> You will need to click the first extension line origin > click the second extension line origin > specify dimension
line location. Repeat this process to add dimensions for the casework.
» [STEP 08] Make a block for the elevation.

o Select the elevation, including lines and dimensions.
= Type [b], press [enter] to open [Block Definition]

o Define the name [000_Elevation-A]

= Click [OK] to finish the command
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« [STEP 09] Organize your drawings.

> Move the inserted — reference images to 75’ plan north.
= Move your section and elevation on the right side of the floor plans.

i

(CO 3) Add/Edit Text & Annotation (in model space — annotative) - M Text,
Text Style, M leader, and Multileader Style

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/

visualgraphiccomm/?p=80

In this tutorial, students will learn how to add and edit text and annotation in the drawing area by using [MULTILINE
TEXT], [TEXTSTYLE], [MULTILINE LEADER], and [LEADERSTYLE]
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Add room names and room numbers on the floor plan.

+ [STEP 01] Switch to the [A-ANNO-TEXT] layer
+ [STEP 02] Adjust units by typing [UN] and press [enter] to open [Drawing units].

o The current unit precision is 0' -0 1/16"
 Change the unit precision to 0'-0 1/32”
> Click [OK] to close the Drawing units window
« [STEP 03] Add two text styles for the room names and room numbers

= From the Annotate tab, Text panel on the ribbon, Click [Standard] > Click [Manage Text Styles]
DEHBLdES -+
Home Insert Parametric View Manay

A %8¢ | Standard O ’-—-‘ A

Multi[ine-_E' AaBb123 Dimension —
Text |A]
Standard

Start ‘Manaﬂe Text Styles.. Jyeon_Cho_04*
= - e .
= On [Text Style] window, click [New]
> Enter Style name [Annotative 1-8] and click [OK]
 Confirm [Annotative] is checked, update Paper Text Height to [0-0 1/8"]
o Click [Apply]
o Click [Set Current]
= Click [New]
o Enter Style name [Annotative 3-32] and click [OK]

- Confirm [Annotative] is checked, update Paper Text Height to [0"-0 3/32"]
> Click [Apply] and click [Close]

(i

|

AutoCAD Session 4 | 70



A Text Style b4
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» [STEP 04] Add room name

o Verify the Text Style is [Annotative 1-8] from [Annotate] tab, on [Text] panel
o Click [Multiline Text] from [Annotate] tab, on [Text] panel
or, Type [mt] and press [Enter]
o Define a text box for a room name. Using All Caps are recommended for a room name. Sometimes, use an
acronym. (e.g., LIVING RM)
= Enter [a room name] and click a point outside of the text box.
» [STEP 05] Add room number

o Verify the Text Style is [Annotative 3-32] from [Annotate] tab, on [Text] panel

o Click [Multiline Text] from [Annotate] tab, on [Text] panel
or, Type [mt] and press [Enter]

= Define a text box for a room number.

- Enter [a room name] and click a point outside of the text box. Typically, each room requires one number, e.g., 102
(The first number (1) indicates the floor number. In this case, the living room is located on the first level. The
second and the third number (02) indicate room number that starts from the main entry to clockwise. In this case,
the HALL is 101; LIVING RM is 102.

= Draw a box around using [RECTANGLE]

« [STEP 06] Create a block for the room name and number that you just created. Name the block to [000_Room name
and number]
Note. This strategy is useful because once the block is updated on the floor plan, the room names and room numbers
are automatically updated on other plans like a ceiling plan, finish plan and more.

« [STEP 07] Use [Edit Block-in Place] to copy the room name and number to all rooms > Edit the names and numbers by
double-clicking the name and the number > Click [Save Changes] to close [Edit Block-in Place]

+ [STEP 08] Update the block from [A-ANNO-TEXT] layer to [0] layer

71 | AutoCAD Session 4




¥ A [m o ="

Add text and annotate on the floor plan

« [STEP 01] Switch to [A-ANNO] layer
« [STEP 02] Draw lines for openings and change [line type] to [Dashed)]

e En LA [ e e W [ED e Ty 2

» [STEP 03] Add multiline texts
= Add [OPEN TO BELOW] text on the second level above the LIVING RM-102. Make sure the scale is 3/16” =1' -0"
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while you add the text
= Add [OPEN TO HALL] and [OPEN TO KITCHEN] texts on the [ELEVATION A]. Make sure the scale is 3/8" =1'

-0 while you add the text

Add annotates on the elevation A

+ [STEP 01] Switch to [A-ANNO-TEXT]
« [STEP 02] Click [Manage Multileader Styles] from Annotation tab, Leader panel, under Standard

Multiline * Dimension enter Centerline Multileader
4 AT ey o 1 Quick M4 Cont £ \

Manage Multileader Styles_

Press F1 for more help

« [STEP 03] Click [NEW] > Add a new name for leader style [Annotative 3-32] > Check Annotative box on > Click
[Continue]

« [STEP 04] Update these values to 3/32” — Text height from Content tab, Landing gap from Content tab, Arrowhead
size from Leader Format, Break size from Leader Format, and Set Landing distance from Leader Structure > Click
[OK] to close the window

» [STEP 05] Click [Set Current]

« [STEP 06] Click [Multileader] from the Annotate tab, on the Leader panel
or, type [MLD] to add leader and text

SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Chapter 5. Draw ceiling plans

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Draw RCPs from Floor plans
(CO 2) Add/Edit Hatch
(CO 3) Create a legend for the RCPs

‘¥’ Session Highlights

At the end of the session, students can create the graphics below.
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E:I Lecture Contents

(CO 1) Draw Reflected ceiling plans (RCPs) from floor plans

’ﬂ YouTube element has been excluded from this version of the text. You can view it online here: hitps_/iastate pressbooks pub/
V

isualgraphiccomm/?p=82

In this tutorial, you will learn how to draw an RCP in AutoCAD.
Open your AutoCAD file

Copy elements from the floor plan

« [STEP 01] Turn layers off that are not needed to copy for the RCPs.
Turn off the following layers: A-ANNO, A-ANNO-DIMS, A-ANNO-TEXT, ANNO-TTLB, A-CLNG, A-CLNG-
PATT, A-DETL, A-FLOR, A-FLOR-FNSH, A-FLOR-HRAL, A-LWT-OBJECT, A-LWT-SECTION, A-LWT-SURFACE,
Defpoints, I-FURN, P-FIX, S-LEVEL
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« [STEP 02] Copy the remaining elements to 100’ plan south direction
« [STEP 03] Turn on all layers
« [STEP 04] Clean up the plan

> In the space, we want to show all door openings, but not the doors themselves. To remove the door swing, you
must Explode the door blocks and remove the doors themselves and swings
o For the casework, remove the casework that is not below 5 ft.
= Extend lines as needed to clean up the plan
[STEP 05] Lock [S-GRID] layer > Select all walls and elements for the RCPs > Switch to the [A-CLNG] layer.
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« [STEP 06] Make the [A-CLNG] layer to the Current Layer
rnig A e | B, g 2

LAYER PROPERTIES MAMAGER

HEEEENENONREEROEEE]

+ [STEP 08] Make the [A-CLNG-PATT] layer to the Current Layer > Confirm the layer color to 34 > Add ceiling pattern
+ [STEP 09] Make the [A-CLNG-PATT] layer to the Current Layer > Add ceiling annotation
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« [STEP 11] Create Lighting symbols

= You can bring lighting symbols (blocks) from other websites or the samples from Electrical-lighting folders using
[DESIGN CENTER]
= And you also can make your own symbols for your project. I created eight types of lighting fixtures

6" RECESSED LED LIGHT

10" SURFACE MOUNTED LED LIGHT

4" WALL MOUNTED LED LIGHT

32" PENDANT LED LIGHT

28" DECORATIVE PENDANT

LIGHT

48" SUSPENDED LED LIGHT

24" UNDER CABINET LIGHT

36" UNDER CABINET LIGHT

« [STEP 12] Add [A-CLNG-FIXT], color — 190, lineweight — 0.25mm > Place lighting symbols (blocks) in the floor plans
> Switch the light symbols to [A-CLNG-FIXT]

« [STEP 13] Select all lighting symbols from the floor plans > Create a block [000-lighting fixtures] > Move the block to
the RCPs
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« [STEP 14] Select the block on the RCPs> Mouse right-click > Select [Edit Block in-place] > Adjust and align the
lighting fixture with add dimensions > Click [Save changes]
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(CO 2) Add /Edit Hatch

A YouTube element has been excluded from this version of the text. You can view it online here: htips_.//iastate pressbooks pub/

visualgraphiccomm/?p=82

« [STEP 1] Hide unnecessary layers for better hatch results

o Confirm the current layer is [0] layer
o Turn off all layers except [0], [A-WALL], [A-LWT-SECTION], and [A-CLNG] layers

B e dsseme Pewnee Vs Massge Do Anws Colessme D Tess  Famaied dpes  downe

‘.. A [ . T .__.. a . L L, @ LB -_J j

ERDOERE000NENEEDECONERRRCEEED
I

« [STEP 2] Draw lines or pline to create a closed object

= Hatch only recognizes a closed object. Thus you must make a closed pline or lines that are completely closed. If
you are unsure the object is closed or not, you have to try the Hatch command first. If the hatch command doesn’t
work, you have to redraw using [PLINE] or use [PEDIT] to convert from lines to [pline].

R rore et Aeeteis et S Mowge  Outpst Sbem  (lesess G fesh  Famend g dche e
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» [STEP 3] Add hatch for the wall

» Confirm the current layer is [A-WALL)

o Click the Hatch icon from the [HOME] tab, on the Draw panel
or, type [H] and press [ENTER]

> Select Solid from the [HATCH EDITOR] tab, on the [PATTERN] panel

o Select color nine from the [HATCH EDITOR] tab, on the [PROPERTIES] panel

= As you move your mouse cursor over a closed object, the hatch pattern fills the area. If you don't get the preview,
that means you don't have a closed object.

= You can select multiple files for one hatch command
= Press [ENTER] to finish the hatch command

[ Feme it vwisn  Fwimec e Maa Ouipd Akdim Colldbmair Hrprs b Fesinidgs 100 (i ) denme e

Lic(wW)E 2 2 4[;]' = ‘/ .

+ [STEP 4] Copy wall fills to RCPs

o Select the wall fills you just made. if necessary, you also can make a block for the wall fills by typing [B] and press
[ENTER]

o Change drawing order to [SEND TO BACK] by clicking mouse right-click and select [SEND TO BACK]

> Copy the wall fills from the floor plans to the RCPs
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» [STEP 5] Add hatch for the section view

= Select the section view

= Mouse right-click > select [EDIT BLOCK IN-PLACE] > Click [OK]

= Draw lines or polylines to make a closed object. Make sure you are in a correct layer

o Select [HATCH] icon from [HOME] tab, on [DRAW] panel
or, Type [H], and press [ENTER] key

o Select a closed wall, floor, ceiling area. You can select multiple areas for one hatch—Press the [ENTER] key to
finish the comment.

= Update the hatch fill layer to [A-LWT-SECTION]

> Once you finish hatching, click [SAVE CHANGES] to save the block > Click [OK]

+ [STEP 6] Turn on all layers
The Hatch command is to fill an enclosed area or a selected-closed object with hatch patterns or fill.
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Hatch is often used to add a fill to the wall, floor, and ceiling thickness for better readability.

Moreover, the hatch is also used to add patterns on a surface to express the finishes.

In this tutorial, you will practice adding solid fills on the wall of the floor plans and RCPs. This is commonly referred to as
poche. Additionally, add a hatch pattern on the wall, floor, and ceiling of the section view.

(CO 3) Create a legend for the RCPs

A YouTube element has been excluded from this version of the text. You can view it online here: https_//iastate pressbooks pub/

visualgraphiccomm/?p=82

In your RCPs, a legend is necessary to inform what items are included, such as lighting fixtures, finishes, equipment, HVAC,

and more that are used in your RCPs.

In this tutorial, you will make a lighting legend that you used in your RCPs

« [STEP 1] Find/organize the lighting fixtures that you used

o

o

o

Copy the lighting block from the RCP to an empty drawing area

Explode the lighting block by typing [X] and press the [ENTER] key

Remove all dimensions from the exploded lighting block. You can lock the [A-CLNG-FIXT] > select the
dimensions > delete the selected dimensions by press the [DELETE] key, or type [ERASE] and press the [ENTER]
key

Delete duplicated lighting fixtures. You only need one lighting fixture block of each lighting fixture type.

Organize the lighting fixtures vertically. You can draw a line for a reference.

AutoCAD session 5 | 84



» [STEP 2] Create a table with lines

= AutoCAD offers a Table tool to create a table. You can find the tool from the [ANNOTATE] tab under the
[TABLES] panel. However, this table tool is used for very complicated documents. As an interior designer with

more than ten years’ experience in the industry, I still use lines to create a table. Please try the table tool if you
want.

> Copy the reference line for the column lines for the table. You can use the [OFFSET] command, too.
1 — B = BAITH
T |

= Draw rows with lines
> To clean up lines, use [TRIM] commands
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» [STEP 3] Add texts to the table

> Make sure your drawing scale is 3/16"=1"-0."
o Type [MT] and press [ENTER] to draw a text box and add text
> Repeat the [MTEXT] command for other text. You also can copy from what you created.

BATH |
EEENCE

32" PENDANT LED LIGHT

CORATIVE PENDANT

48" SUSPENDED LED LIGHT

mooeL 3 i+ L&~ ~ [T~ = (KX £# Dre
« [STEP 4] Select the table and table contents > Switch to [A-ANNO] layer
« [STEP 5] Make the table as a block [000-Lighting Legend]
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SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Chapter 6. Set sheets

g Session Objectives

Upon completing this session, students will be able to:

(CO 1) Understand Model space and Paper space
(CO 2) Set a new layout — Page layout and plot styles
(CO 3) Set views in Paper space — Defpoints, scaling
(CO 4) Add/Edit/Draw a titleblock

‘¥ Session Highlights

At the end of the session, students can create the graphics below.
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E:, Lecture Contents

(CO 1) Understand Model space and Paper space

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/

visualgraphiccomm/?p=_84

In this tutorial, you will understand the differences between the concept of model space and the concept of paper space.
AutoCAD provides two different types of drawing areas.

+ Model space — A limitless drawing area. You draw at a 1:1 scale.

« Paper space — To prepare your drawing for printing, use paper space. Paper space is a pre-defined and set area. Please
refer to the information from this link.

Clean up the CAD file

« Purge is a command to automatically removed all layers, blocks, dimension styles, and more items that are not
currently used in your document. This command is a useful command to reduce the file size.
« Type [PURGE], and press [ENTER] key, select [PURGE ALL], and purge all again until the [PURGE ALL] is grayed out.
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(CO 2) Set a new layout — Page setup

A YouTube element has been excluded from this version of the text. You can view it online here: htips_//iastate pressbooks pub/

visualgraphiccomm/?p=_84

In this tutorial, you will understand how to set a new layout in the paper space using page setup.

Once you click [LAYOUT 1}, you will see the models you made in the model space in a rectangular box. It is called a viewport.

There is a dashed line that is inside of the white space; it is called a printable area.

And the white space called a layout. Once you change the paper size to print, the layout and the printable area will change
accordingly.

Update Page setup for 11inx 17 in PDF

« [STEP 1] Open Page setup manager

]

o

o

Mouse right-click on [LAYOUT 1]
Click [PAGE SETUP MANAGER]
Click [*Layout1*] and select [MODIFY] to open the Page setup

« [STEP 2] Edit Page Setup

o

o

o

Click the name of printer/plotter and switch to [DWG To PDF.pc3]
Update paper size to [ANSI full-bleed B (17.00 x 11.00 Inches)
Confirm What to plot: [LAYOUT]

Confirm Plot scale to [1:1]

Change Plot style table to [monochrome.ctb]

AutoCAD Session 6 | 90



> Check [Display plot styles]

> Check [Landscape] for the drawing orientation
¢ Click [OK] — Page Setup — Layout 1

o Click [Close] — Page Setup Manager

| | | i Ul Li
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Page setup Plot style table (pen assigrments)
o> - I C
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| Shaded viewport options E
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“LayoutZ™ = 1 100
T Paper size Plot options
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Impart.. [[]#lot transparency
: Flotarea Plot scale [APlot with plot styles
Selected page sehup details \What to piat: Fit to paper [APtot paperspace last
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The L wil not be plotted unless & new plotier A i3 inch 0 -
configuration name is selected, [Cltot upside-dawn
[CIDisplay when creating a new layout | Cose =

+ [STEP 3] Confirm the layout with an updated sheet size

mrn [ 13 = | =[]0 - 5 IR L K O Dalinghden

+ [STEP 4] Update the name of the sheets and add sheets

= To update the name of sheet > mouse-right click on the tab > Click[RENAME] > Rename on the tab
= To add a sheet > click [+] tab

= Update the name of Layout1 to A101. A101 is for the floor plans
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= Update the name of Layout2 to A102. A102 is for the furniture plans
= Add a new layout and change the name to A401. A401 is for RCPs
= Add a new layout and change the name to A601. A601 is for the section view and the elevation

......

Regenerating layout.
il Regenerating model.
A FE DYy

Model , A101 A102 | A401 , AG01 f +

« [STEP 5] Update other sheets to 11x17 PDF

= Mouse right-click on A102

= Open Page Setup Manger

= Select *A101*

o Click [Set Current]

o Click [Close]

= Repeat this process for A401 and A601

(CO 3) Add/Edit/Draw a titleblock

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/

visualgraphiccomm/?p=_84

» [STEP 1] Draw a titleblock

o Select [A101] sheet to open the sheet
o Confirm your current layer is [0]

= Draw a rectangle for a paper size box — Type [REC], press [Enter] key > Type [0,0], press [Enter] key > Type
[17",11"]. Press [Enter] key

o Draw a titleblock outline using the paper size box — Type [O], press [Enter] key > Type [1/4”], press [Enter] key >
Click the inside of the sheet
= Draw lines for the titleblock. Please refer to the image below
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» [STEP 2] Add titleblock information

]

Sheet number — A101

Project name — Eames House, House
Your name — First name and last name
Course number

Submission date

Add text using [MT] for titleblock information. Verify the text size is 3/32". You may rotate the text 90 degrees.

» [STEP 3] Add the titleblock to other sheets

o

]

Click [Inset] from [Insert] tab, on [Block] panel
Select [000_Titleblock_11x17]
Type [0,0], press [Enter] key

Select the titleblock and the information except for the Sheet number.

Create a block for the selected elements — Name the block — [000_Titleblock_11x17]
Insert the titleblock to A102, A401, and A601

Switch the Titleblocks to [A-ANNO-TTLB]

Copy and modify the sheet number to A102, A401, and A601

+ Now you are ready to add a titleblock on the paper space.
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(CO 4) Set views in Paper space — Defpoints, scaling

A YouTube element has been excluded from this version of the text. You can view it online here: htips_.//iastate pressbooks pub/

visualgraphiccomm/?p=84

Now you are ready to set the views in the sheets

+ [STEP 1] Change a viewport size and the viewport layer
> Once you click, a viewport can be changed by stretching the corner of the viewport line.

omars: _
5. - Specify stretch point or [Sase podnt Copy Unde eXiE]: <Ortho offs
R = & - - E B ¥ £ 5
o Select the viewport > switch to [Defpoints] layer. The [Defpoints] layer is set up by default as a non-plot layer.
i o - 2% s e e s e R
£ Defpoints g =8 . wh... [l wh... Continu... Continu
~ | FACE ] I AL AP S Bl ON Bl ION Caskiea bl

+ [STEP 2] Update the scale of the viewport

o After changing the viewport size > double-click the viewport > Zoom in and out > Pan the view to make the view
centered
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o Click a scale on the application status bar, and select a desired scale for the floor plan
o If the dimensions have disappeared, click on the Show Annotation icon on the application status bar
+ [STEP 3] If you want to add a new viewport, use the [MVIEW] command.

= Type [MV], and press [Enter] > Click the first point to draw a rectangle > Click a second point to finish the
rectangle. It will automatically show the drawings

o If you have a viewport to copy, you can copy the viewport and pan the view

= Sometimes a copied viewport will show in color. To change it to black and white, double-click the inside of the
viewport > type [RE] and press [ENTER] key > double-click the outside of the viewport

M Y P A

T -
: l—--‘rﬁ‘—l—r i

TRl |

w2 e - [T [ T A A O Duing 8 Amcsten - - 2 B E) S

95 | AutoCAD Session 6



[STEP 4] Update layer visibility for the viewports

= Open [LAYER PROPERTIES MANAGER]
> A101 is for dimensioned floor plans. Thus, it would help if you hid the [I-FURN], [[-CASE], and [P-FIXT] layers
o Double chck the \uewport and click [VP FREEZE] on the I FURN] [I-CASE], and [P- F[XT] layers
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[STEP 5] Set a furniture plan sheet

o The scale of the furniture planis 3/16"= 1.
o VP Freeze [A-ANNO], [A-ANNO-DIMS], [S-GRID], and [S-LEVEL]
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[STEP 6] Set an RCP sheet
o The scale of the RCPis 3/16"= 1"
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« [STEP 7] Set a section view and elevation sheet

= The scale of the section view is 3/16"=1.
= The scale of the elevation is 3/8"= 1.
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SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Chapter 7. Symbols and prints

d Session Objectives

Upon completing this session, students will be able to:

(CO 1) Add/Edit symbols in Paper spaces — drawing title, elevation symbol and section letters, north arrow
(CO 2) Printing

¥ Session Highlights

At the end of the session, students can create the graphics below.
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@ Lecture Contents

(CO 1) Add/Edit symbols in Paper spaces- drawing title, elevation symbol and
section letters, north arrow

A YouTube element has been excluded from this version of the text. You can view it online here: https_//iastate pressbooks pub/
visualgraphiccomm/?p=86

Open your AutoCAD file.

Add drawing title and scale for Floor plans, Furniture plans, RCPs, Section view, and elevation

« [STEP 1] Click [A101] sheet to open the view
+ [STEP 2] Open [DESIGN CENTER]
+ [STEP 3] Find [A-01.dwg] for a sample drawing title

o Click the [HOME] icon
= Open [Sheet Sets] > [Architectural] > [A-01.dwg]
= Open [Blocks]
= Double click [Drawing Title]
« [STEP 4] Add on the sheet
+ [STEP 5] Double-click the inserted drawing title and edit the attribute. Adjust the title line length
+ [STEP 6] Copy the edited drawing title for the 2nd-floor plan and double-click to edit the drawing title
+ [STEP 7] Repeat [STEP 6] for other drawings
+ [STEP 8] Update the drawing titles to the [A-ANNO] layer
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Add an elevation symbol from [TOOL PALETTES]

+ [STEP 1] Open [TOOL PALETTES] from [VIEW] tab, on [PALETTES]

» [STEP 2] Click [Annotation] tab from [TOOL PALETTES]

« [STEP 3] Select [CALLOUT BUBBLE — IMPERIAL]

+ [STEP 4] Add the symbol on the first floor

+ [STEP 5] Double-click to open the attribute editor, and update information
« [STEP 6] Update scale to 0.75

« [STEP 7] Update the symbols to the [A-ANNO] layer
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Add section letters with [MTEXT]

« [STEP1
« [STEP2
+ [STEP3
« [STEP4
« [STEPS5S
- [STEP6

Type [MT], press [ENTER] key

Draw a text box to add the section letter
Text size update to 1/8”

Add section letter

Repeat this process for other sections
Update section letter to [A-ANNO] layer

[ i e i e S S

Add north arrow with drawing tools [LINE], [CIRCLE], [MTEXT], & [HATCH]

« [STEP 1] Draw a north arrow in the paper space and make a block
« [STEP 2] Rotate the north arrow to match the information from Eames House plan images
« [STEP 3] Place the north arrow to Floor plans, Furniture plans, RCPs
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(CO 2) Printing

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/

visualgraphiccomm/?p=86

Update the print setup for each layout

+ [STEP 1] Open [PAGE SETUP MANAGER] by mouse right-click on each layout.

« [STEP 2] Click [Modify] to open [Page setup]

« [STEP 3] Plot style table is already set to Monochrome.ctb. The Monochrome style turns all layer colors to black. Since
we don’t want our wall, floor, and ceiling thickness to be black, we need to customize the plot style.

» [STEP 4] Click the edit button next to the name

« [STEP 5] Click [Color 9] from [PLOT STYLES] and change to [USE OBJECT COLOR]

+ [STEP 6] Click [SAVE & CLOSE]

« [STEP 7] If the color is not changed automatically on your paper space, use the [REGEN] command for the views.
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+ [STEP 1] Click a layout that you want to print
+ [STEP 2] Press [CTRL+P] to open [PLOT]

« [STEP 3] Click [PREVIEW] from the [PLOT] window
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« [STEP 4] Click [OK] > find a location to save > click [SAVE]

Print multiple sheets at once

+ [STEP 1] Click [Home] button > Select [Publish] to open [PUBLISH] window
+ [STEP 2] Select the drawing model if it shows, and mouse right-click > click [Remove]
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[STEP 3] Click [PUBLISH]

[STEP 4] Specify the file location to save > click [SELECT]

[STEP 5] If you want to save the current list of sheets for later use, click [Yes]
[STEP 6] Click [close], once a processing background job window popup
]

[STEP 7] Wait until the completion message comes

| I I [ S

) Plotand Publish Job Complete  [X|
No errors or warnings found
Click to view plot and publish details...

NG
Vewper [ ] &~ Y.~ [Z]E]~ = 5 [K] X £ Drafing & Annctation» + %0 [3 ] B 31 =

SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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PART TWO. REVIT

Chapter 8. Introduction to Revit

+ Purpose of using Revit — How @ Why Interior Design uses Revit

+ Install Revit

+ Understand Project Templates — Default and Own

+ Save Revit file — Set the project folder and backup file

+ Open an existing project file

+ Keyboard shortcuts

+ Understand the User Interface — Toolbar, Properties, Drawing area, Option bar, and Project Browser

Chapter q. Create a Site

+ Understand the site plan and information

+ Set the project location and understand building base point

+ Find GIS information

+ Add & Edit Site — Topo surface, roads, side works, property line, building pod, surrounding buildings, and trees
+ Define true north and project north

Chapter 10. Set Grids, Levels, Dimensions, & Building columns

+ Import CAD drawings— Floor plans, building elevations, and sections
+ Adjust and verify the scale

+ Create and modify grids and levels

+ Create plan views— Floors and ceilings

» Create columns with dimensions

Chapter 11. Add/Edit Beam, Walls, & Curtain Walls

+ Add/Edit Beam

+ Create walls

+ Edit walls wall properties — Wall thickness, Wall details, €/ Finishes
« Edit/add wall properties — Wall opening, wall sweep

» Add/Edit Curtainwalls, Mullions, & Panels
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Chapter 12. Understand Visibility settings, Add/Edit Floor & Ceiling

+ Understand View template, visibility graphics
+ Understand View range

+ Add/Edit Floors & Floor Properties

+ Add/Edit Ceilings & Ceiling Properties

Chapter 13. Add/Edit Stairs, Rails, & Roof

+ Add/Edit Stair — three types of staircases
+ Add/Edit Railing
+ Add/Edit Roof

Chapter 14. Add/Edit Windows, Doors, Lighting Fixtures, Furniture, Tags, &
Sheets

+ Understand the concept of family file

+ Add/Edit Doors and Windows

+ Add Tags

+ Add/Edit Lighting fixtures

+ Add/Edit Titleblocks

+ Insert Plan views and symbols — North arrow and graphic scale

Chapter 15. Add/Edit Model-in-Place Components & Edit Family

+ Add/Edit Furniture families
+ Add/Edit Model-in-place components — Custom casework
+ Add/Edit a New Family — Furniture
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Chapter 16. Add/Edit Elevation, Section, Detail, Text, Annotation, & Rooms

+ Add/Edit Elevations & Sections — Adjust crop region
+ Add/Edit Detail views

+ Add Texts & Annotations

+ Add/Edit Rooms, Room tags, Room separators

+ Add/Edit a color fill scheme

Chapter 17. Add/Edit Views, Lighting, & Materials

» Set perspective views

» SetIsometric views

+ Edit Views — Graphic Display styles
+ Test Render

» Setsun

+ Edit Artificial lighting

+ Add/Edit materials

+ Render material managements

Chapter 18. Create Revit Rendering, Revit Clouding Rendering

+ Insert other types of files — Sketchup, AutoCAD
+ Advanced render settings

+ Edit render qualities

+ Understand and make cloud renderings

+ Save Rendering outputs
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Chapter 8. Introduction to Revit

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Purpose of using Revit — How & Why Interior Design uses Revit

(CO 2) Install Revit

(CO 3) Understand Project Templates — Default and Own

(CO 4) Save Revit file — Set the project folder and backup file

(CO 5) Open an existing project file

(CO 6) Keyboard shortcuts

(CO 7) Understand the User Interface — Toolbar, Properties, Drawing area, Option bar, and Project Browser

“®: Session Highlights

At the end of the session, students can create the graphics below.
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E Lecture Contents

(CO 1) Purpose of using Revit - How & Why Interior Design uses Revit

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks. pub/
visualgraphiccomm/?p=88

Introduction of Revit, a BIM (Building Information Model) software

+ Charles River Software originally developed the software in 1997, renamed Revit Technology Corporation in 2000,
and acquired by Autodesk in 2002.

« Autodesk Revit is BIM software for Architects, Interior Designer, Landscape Architects, Structural Engineers, MEP
Engineers, Contractors, and more.

+ Revit can be used as a very powerful collaboration tool among different disciplines in the Architecture, Engineering,
and Construction (AEC) industry.
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+ Revit has a huge library for modeling in the software itself and supports plug-ins, advanced data management systems,
and energy modeling analysis.

+ Revit modeling process is complicated and not easy for a first-time user.

+ Software required better hardware, 40% more expensive than Autodesk CAD but higher productivity.

«+ For architects and interior designers, the software is being used to create construction documents.
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+ Most of the commercial interior design/architectural design firms use Revit.
« Not much of renderings features, but support Virtual Reality plugins.
+ Collaborate with CAD drawing users.

(CO 2) Install Revit

A YouTube element has been excluded from this version of the text. You can view it online here: https.//iastate pressbooks pub/

visualgraphiccomm/?p=88

Install Autodesk Revit

+ [STEP 1] Go to https://www.autodesk.com/education/free-software/revit on your window side in a web browser.
« [STEP 2] Click [CREATE ACCOUNT] if you do not have one. If you have the account, please sign in.
« [STEP 3] Click [Get product] under Revit.
« [STEP 4] Select, windows, 2021, and English. Click [INSTALL].
+ [STEP 5] Accept the license and services agreement.
« [STEP 6] You will get an email from Autodesk for the license information (Product key and Serial Number). It may
need the information for the activation process.
[STEP 7] Click Install.
[STEP 8] Click downloaded installation file to install.
« [STEP 9] Setup Initialization will download actual software to install it will take time.
[
[

STEP 10] While you are installing Select the “Architecture” discipline in the drop-down menu.
STEP 11] After installation, the license information required to activate Revit.

(CO 3) Understand Project Templates — Default and Own

A YouTube element has been excluded from this version of the text. You can view it online here: htips_//iastate pressbooks pub/

visualgraphiccomm/?p=88

Open Revit by double-clicking the Revit Icon.

Once the application opens you can see the HOME page. From the home page, you can open recent project files and recent
family files. Also, you can create a new project file or a new family file.

Create a new project file with Architecture Template.

« [STEP 1] Click [NEW] under Models on the left side of the Home page
+ [STEP 2] Click [Imperial-Construction Template] and select [Imperial-Architectural Template]
« [STEP 3] Click [OK] to create a new project file.
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Recent Files

If you are working on a specific project like a residential building or a commercial project, there are more templates that
Autodesk supports. To open the template, you can click[BROWSE]. And see what template is appropriate for your project.

Additionally, you can also create a project template for your firm. Many firms already created/use their own template (called

a seed file) to save time and resources to develop their construction documents.

(CO 4) Save Revit file — Set the project folder and backup file

visualgraphiccomm/?p=88

A YouTube element has been excluded from this version of the text. You can view it online here: htips_//iastate pressbooks pub/

Saving a file must be a friend of yours. Once you create a new file you must save the Revit file first and work on it later.

Save a file for the first time

« [STEP 1] Click [FILE] tab

» [STEP 2] Select [SAVE AS] from the file menu
« [STEP 3] Select [Project] under the menu

111 | Revit Session 1




m Architecture  Insert  Annotate Analyze  Massing & Site  Collaborate  View Manage  Add-

(3[=]

% Open » [g

Saves current project or family. Saves current
project as a template. Save any family, group or
view to your library.

Cloud Model
Saves the current Revit model to the
cloud.

@

Project
Saves the current Revit project file,

)

=l
R

RTE

Eame.\s »
B Export ]

Family
Saves the current family.

Template
Saves the current Revit project file as a
template.

Library

v B Railing - £) H X
D Ramp [N B @
O Stair - [E-
Circulation Model Room & Are

>4 -

=T
G
Y

+ [STEP 4] Find a folder location to save. If you do not have a folder, you can create a folder by pressing [ALT+5]. it is

recommended to have a project folder to save the project Revit file. You also save other family files (e.g. Furniture,

lighting family that you downloaded) and material images that you found under the project folder. You may draw and

drop the folder to the left side of the browser for future use.
R Save As

? X

v'#ﬁx.,_ﬂemv

Savein: | 2020 ISU-mini-grant

10_Madule
= '0_Proposal

| _AutoCAD
| 003_Enscape

- 100_Received

~

Date modified
8/10/2020 1:28 PM
6/4/2020 2:30 PM
8/16/2020 5:33 PM
8/19/2020 8&:32 PM
8/19/2020 8:33 PM
7/14/2020 10:03 AM

Type

File folder
File folder
File folder
File folder
File folder
File folder

Size

File name: | Eames_House_Project_Yongyeon_Cho_08

v | Files of type: |pfoject|=leg (=.rvt)

Save ||

Tip, I strongly recommend having an external hard drive to save files. If your laptop hard disk is full, your hardware
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performance will be drastically reduced. To prevent this, your working file should be saved in an external hard disk. For
extra safety, it is recommended to use Cloud file storage to save files.

+ [STEP 5] Open a folder to save and make a unique name for the project.

« [STEP 6] Before you click [SAVE], you may consider saving a backup file by clicking [OPTIONS]. Revit will
automatically make backup project files. It is safe to have the backup files, but it will take time for the automatic
backup file while you work on it. You may set the number of backup files (default is 20) by open [Option] in the save as
browser. 5 backup files might be enough.

Savein: | 08_Revit 01 v 4= B X B vews ~

Name Save % B Size

ile Save Options
Screenshots - < folder
Maximum backups:
Worksharing
Make this a Central Model after save
Compact File
Open workset default:

Thumbnail Preview

Source: |Active view/sheet v

[[]Regenerate if view/sheet is not up-to-date.

( o< ) cance

Hlename:% "l
Files of type: |Project Files (%.rvt) v|L Options. .. j
s ) o

Save a file while working or end of the work

« [STEP 1] Click [FILE] tab
+ [STEP 2] Select [SAVE] or simply press [CTRL + S]

(CO 5) Open an existing project file

A YouTube element has been excluded from this version of the text. You can view it online here: https.//iastate pressbooks pub/

visualgraphiccomm/?p=88

Revit has 2 ways to open your project file.

The first method is just double-clicking your Revit project file.
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The second method is opening a file in the application. I recommend this second option due to reducing errors that you
might have, especially, while you are sharing a file with your co-workers.

« [STEP 1] Open the Revit software

» [STEP 2] Click [File] on the tab

« [STEP 3] Click [Open] on the file tab
[
[

STEP 4] Select the file that you want to open under the folder
STEP 5] Click [Open] to open the file

(CO 6) Keyboard shortcuts

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/

visualgraphiccomm/?p=88

To increase productivity, I recommend you become familiar with the following keyboard shortcuts.

MV  Move

TL  Thin Line

VV  Visibility
« ZE  Zoom All to fit

WT  Tile Views

TW  Tab Views
« DI  Aligned Dimension
« DL  Detail Line

« CO Copy

+ RO Rotate

« MA  Match type properties
« AL Align

« PT  Paint

For more information regarding shortcuts
https://www.autodesk.com/shortcuts/revit

(CO 7) Understand the User Interface — Toolbar, Properties, Drawing area,
Option bar, and Project Browser

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/

visualgraphiccomm/?p=88
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Revit’s user interface is similar to AutoCAD’s one including an icon with text, and wording.
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You also can change the Ribbon panel size by clicking the minimize panel button.
T Acchitecture  Inset  Annotate  Analyze  Massing &Site  Collaborate  View  Manage  Add-Ins  Modify

N &

(8 @& &

Medify View _ Visibility/ Filters | Thin Show Remove Cut Render Rend
Templates Graphics Lines | Hidden Lines Hidden Lines Profile in Clo
Select = Graphics ¥ Presenta

Minimize to Tabs @ ﬁ

Plan _ Elevation D
Views b

Minimize to Panel Titles
Minimize to Panel Buttons

Cycle through All Crei

If you accidentally close Properties or Project Browser, you can open with [User Interface]

Select [VIEVV] tab > Click [USER INTERFACE] > Check the box to open.

llaborate Mansge  Add-ins  Modify (of
T : i o e
] oo Do BES B Bamiag @D Y S LOB|6
ut ier Render Render 30 _ Section (lllum Flan Elevmun Drafting Duplicate ngmﬂl S(ludulu Scope  Sheet Revisions Matchline  View Switch _ I Tab  Tile
file inCloud Gallery  View ™ Views View View Box Reference Windows Views Views lm
" Presentation Create Sheet Compositian |
| | Hanagation Bar
| Project Browser
+ Properbes
| ] Status Bar
| o Status Bar - Worksets
g | |+#! Status Bar - Design Options
| g Browser Organization
| 8 Keyboard Shorteuts

image credit: Screen captured and modified by the Author from the application

In the ribbon, you will find many tools for your work.

» Architecture
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Wall Door Windce Compenent Column  focf Cefing Fiomr Cortain Curtain Mullon  Railng Ramp Stair  Medel Model Model | Room  Rloam tren Tag, By Shaft Wall Vetical Domer Gid  Set Show Ref Viewsr
System G Tet Line Goup” Separatoe P Ares” Face Plane
Select ~ Buid Crrculation Model Moo B fees ~ Opening Disturn Work Plane

« Insert

File Architecture

s

Insert  Annotate  Analyze  Massing 8 Site

Collaborate  View Manage Add-Ins  Modify

E®L R DY @ LWalls 2wk

ANENEIIE

Madify| Link Link Link Link DWF  Decal Point Coordination Link Link Manage Import Import Import Load Get Autodesk Load as| Insert |
Revit IFC CAD Topography Markup = Cloud Model PDF Image Links CAD PDF |Image Family Content Group | from File
Select = Link Import » Load from Library
+ Annotate
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Select Dimension = Detail Test Tag = Codor Fill Symibal
+ Analyze
ZIOM  Architecture  Insert  Annotate  Analyze  Massing & Site Collaborate  View  Manage  Add-Ins  Modify =~
= B @ [ RIE
Ly T @ & .. L
Modify| Location System-Zone Create Systems Generate Optimize  Energy Pathof Reveal
Energy Model Analysis Settings Travel Obstacles
Select = Energy Optimization Route Analysis =

+ Massing & site
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+ Modify
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For more information regarding the user interface, please read this page
SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Chapter g. Create a site

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Understand the site plan and information

(CO 2) Set the project location and understand building base point

(CO 3) Import google maps and define true north & project north

(CO 4) Find GIS information

(CO 5) Add & Edit Site — Topo surface, roads, side works, property line, building pod, surrounding buildings, and trees

! Session Highlights

At the end of the session, students can create the graphics below.

Site F & 50 view 01 X ¥

r-ae 16 N o rald ¢ s || yete EEHC QO GMAES 0 RS < ' >
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E Lecture Contents

(CO 1) Understand the site plan and information

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/
visualgraphiccomm/?p=90

The site plan is an architectural plan of proposed improvements to a given lot. A site plan usually shows a building footprint,

travel ways, parking, and landscaping and garden elements (Department of Building and Development Land Development,
2009).

A

208 Wow [EoETTy DRANG TITLE: PROJECT: CRAUNG No
T w: | ac | SITE PLAN LOCHABER CENTRE
orcntacts Itd, T~  fear—Toaw Al
(oo o e NTS APR 280 LOCHABER NS y,

image credit: Archibald & Fraser Architects Ltd. — Wikimedia Commons — File: Lochaber Centre Site Plan.jpg

A site plan is a “set of construction drawings that a building or contractor uses to make improvements to the property.
Counties can use the site plan to verify that development codes are being met and as a historical resource. Site plans are often

prepared by a design consultant who must be either a licensed engineer, architect, landscape architect, or land surveyor”
(Chesterfield County, 2009).

Asite plan is a top view of a property that is drawn to scale. A site plan can show
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« Property lines

« Outline of existing and proposed building and structures
« Parking lots, indicating parking spaces

+ Driveways

« Surrounding streets

« Landscaping areas

« Terrains

(CO 2) Set the project location and understand building base point

A YouTube element has been excluded from this version of the text. You can view it online here: htips_//iastate pressbooks pub/

visualgraphiccomm/?p=90

Draw the building footprint for the site plan
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+ [STEP 1] Acknowledge the overall size of the building.

o The size of the house part of the Eames House project is 58"-7" x 20™-4."
« [STEP 2] Select [WALL] from [ARCHITECTURE] tab, under [Build] panel
Or, Type [WA] on your keyboard

> Draw only overall exterior walls on level 1
> Make sure your walls are [Project North] on the [Properties] palette.
> Confirm the wall is — Basic Wall/Generic-8", Unconnected Height 20" 0.”
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« [STEP 3] Draw the building footprint

o Click a drawing area
> Move the mouse to the right-side
= Enter 58'7” on your keyboard > press [ENTER] key
= Move your mouse to the down-side
= Enter 20'4” on your keyboard > press [ENTER] key
= Move your mouse to the left-side
o Click the third point and forth to create the building
+ [STEP 4] Move the elevation symbols closer to the close the building

o Select one elevation symbol

> Type [MV]

= And click one point and move the mouse and click the target point to complete the command.
> Repeat this process to other elevation symbols

Set the project location

This setting is for sun orientation and weather information

P frchitecture  Inset  Annotate  Analyze  Massing &Site  Collaborate  View Add-Ins  Modify -

Main Model i
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Properties | X i
T  Floor Plan -
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t'rlcw ?ﬂle : _1_"8 =10 Location Weather and Site x
Scale Value %5
Display Model “Normal ' Loation (538
Detail Level Coarse
Parts Visibilty Show Original Define Lacation by:
Visibility/Graphics Overr.. | Edi Internet Mapping Service -
Graphic Display Options [ Edita. |
Orientation Preject North Project Address:
Wall Join Display Clean all wall joins . m
Discipline Architectural — e T | T — - _:I
Show Hidden Lines By Discipline T Moutitin _ “ = i:‘ H
Color Scheme Location  Background Topanga Loy \ hl&lr_\_‘!;HLIywc
Color Scheme cnones | A | NN
Default Analysis Display ... None \ '\'*‘«__Wf\
Sun Path im| _x Los{,A’nth
Underlay £ e —— “\‘“'(_LEE
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Unbounded e o
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b o0 ==th G
2 mg ©2020 TomTor & 2020 HERE Eﬁ”%w%m‘im
Crop View {m [[] Use Daylight Savings time
Crop Region Visible O
Annotation Crop Ol E Tl Heb
View Range o Edit.

+ [STEP 1] Select [LOCATION] from [MANAGE] tab, under [PROJECT LOCATION]

« [STEP 2] Enter the project address (Eames House address is 203 N. Chautauqua Blvd. Pacific Palisades, CA) and Select
[SEARCH]

« [STEP 3] Select a Weather Station near the project location
« [STEP 4] Click [OK][ to complete the command
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(CO 3) Import google maps and define true north & project north

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/

visualgraphiccomm/?p=90

Sawve site information from Google Map

« [STEP 1] Open your web browser and go to [GOOGLE MAP] - https://www.google.com/maps

+ [STEP 2] Search the address [for Eames House project, 203 N. Chautauqua Blvd. Pacific Palisades, California]

+ [STEP 3] Use [Snipping tool] (search Snipping tool from your program list) — Screenshot — must include the building,
and the property line, and the scale on the bottom left corner. For your drawing accuracy, I recommend saving both
the map image and the satellite map image.

= ~
- - o< o

image credit: search result from Google map

+ [STEP 4] Save the snipped image file in JPG file format in your project folder

Insert site information from google map

« [STEP 1] Open [SITE] plan by double-clicking from the [PROJECT BROWSER]
+ [STEP 2] Move the project origin to the building bottom left corner
+ [STEP 3] Change the orientation to [TRUE NORTH]
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« [STEP 4] Select [[IMPORT IMAGE], from [INSERT] tab
+ [STEP 5] Open the project folder and select the google map and click [OPEN]
+ [STEP 6] Click on the center of the drawing area
. [STEP 7] Repeat this process for the satellite map
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Adjust the scale of the imported google map

[STEP 1] Select the two imported maps by crossing selection
[STEP 2] Click [SCALE] from [MODIFY/RASTER IMAGE] tab, under [MODIFY] panel
or, Type [RE] for adjusting the scale

[STEP 3] Zoom-in to find the graphic scale on the bottom right side of the map
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+ [STEP 4] Click 0ft — click 50 ft — type 50’ — Enter
+ [STEP 5] Move the imported raster maps to be centered
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Adjust the orientation of the imported google maps according to the building footprint

+ [STEP 1] Select the imported google maps

+ [STEP 2] Select [ROTATE] from [MODIFY] tab, under [MODIFY] panel
Or, Type [RO] on your keyboard

+ [STEP 3] Select [PLACE]

+ [STEP 4] Click the base point to rotate, click an appropriate point to rotate.
Remember how many degrees you rotated (for Eames House, 75.56 clockwise)
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+ [STEP 5] Relocate the imported google maps, if needed

+ [STEP 6] Select only the satellite map > click [SEND TO BACK] from [MODIFY/RASTER IMAGE] under [ARRANGE]
panel

+ [STEP 7] Select the project base origin

+ [STEP 8] Click [ANGLE TO TRUE NORTH]

« [STEP 9] Type [-75.56], and press [ENTER] key (for Eames House, we rotated the google images to 75.56 clockwise, so
you need to re-rotate the origin to 75.56 counter-clock-wise)
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« [STEP 10] Change the view to [PROJECT NORTH] from the [PROPORTIES] to check the plan rotated the right-way.
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Crop the view to only the site plan area

+ [STEP 1] Select [CROP VIEW] and [CROP REGION VISIBLE] from the [PROPERTIES] panel
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« [STEP 2] Adjust the region for the view
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(CO 4) Find GIS information

A YouTube element has been excluded from this version of the text. You can view it online here: htips_.//iastate pressbooks pub/
visualgraphiccomm/?p=90

In this tutorial, we will find GIS information from CADMAPPER

« [STEP 1] Open your web browser, go to https://cadmapper.com/

« [STEP 2] Sign up for free if you don’t have an account. Sign on the website.

« [STEP 3] Enter the project address [203 N. Chautauqua Blvd. Pacific Palisades, CA] and search

« [STEP 4] Adjust the area for your project by zooming in and changing the selected area. It is free up to 1 km?2
[STEP 5] Click [CREATE FILE] to generate the 3D model
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image credit: Screen captured from www.cadmapper.com

+ [STEP 6] You can see the preview for your confirmation. Click[DOWNLOAD]
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image credit: Screen captured from www.cadmapper.com

+ [STEP 7] Once the download is done, open the folder to extract the zip file
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+ [STEP 8] Extract the zip file
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+ [STEP 9] Copy the files to your project folder and read the License.txt file before you use the file
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o J
| LICENSE.txt - Notepad - o x

File Edt Format View Help

The downloaded file must be distributed with this accompanying license text.Map data (c) OpenStreetMap contributors.license details
avallable at http://www.openstreetmap.org/copyright---Data via USGS Mational Elevation Dataset (NED). All NED data are in the public
domain.---Data via NASA Shuttle Radar Topography Mission (SRTM). All SRTM data are in the public domain.

« [STEP 10] Open the LEVEL 1 view

« [STEP 11] Click [IMPORT CAD)], from [INSERT] tab, under [IMPORT] panel

+ [STEP 12] Open the project folder, change the file type to [DXEF files], change colors to [Black and White], change
Import units to [meter], Click [OPEN]
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« [STEP 13] Move the imported CAD site information to the site. To move the map, you have to unpin before you move
the site.

» [STEP 14] Switch the view to [SITE] view, Uncheck [CROP VIEW] from [PROPERTIES]

« [STEP 15] Rotate the imported CAD site map to match the imported GOOGLE MAP (75.56 degrees clockwise)

+ [STEP 16] Move the imported CAD site map to match the imported GOOGLE MAP.

> To move correctly, you can switch the graphic display option to [WIREFRAME]
o Refer to other building locations and road locations to get the right location aligned
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+ [STEP 17] Open [WEST] view
+ [STEP 18] Move the imported CAD site map to match the building level 1

> You can type the Base Offset or manually move to match
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(CO 5) Add & Edit Site — Topo surface, roads, side works, property line, building
pod, surrounding buildings, and trees

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/
visualgraphiccomm/?p=90
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Create a TOPO SURFACE

Note, Building sight might be completely flat or with little level change. Please try the TOPO SURFACE tool to make the
site model.

+ [STEP 1] Select [TOPOSURFACE], from [MASSING & SITE] under [MODEL SITE]

+ [STEP 2] Select [CREATE FROM IMPORT], from [MODIFY/EDIT SURFACE] under [TOOLS]

+ [STEP 3] Select [SELECT IMPORT INSTANCE]

+ [STEP 4] Select the imported CAD site map

+ [STEP 5] Only check [COUNTOURS] from the ADD POINTS FROM SELECTED LAYERS] window

i
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« [STEP 6] Adjust point locations if needed
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+ [STEP 7] Click the green check to complete the topo surface tool

Edit TOPO SURFACE

+ [STEP 1] If you want to edit the topo surface, select the topography and select [EDIT SURFACE]
« [STEP 2] If you want to add the point, use [PLACE POINT]
« [STEP 3] If you want to remove the point, select the point and press the [DELETE] key

Topography line setting

« [STEP 1] Select [SITE SETTING] from [MASSING & SITE] tab, under [MODEL SITE].

o Itis a small arrow on the panel
B Achitecture  Inset  Annotete  Anslyze  Mossing &Site  Collsborate  View  Manage  Add-ins  Modify =+

U Qoefbsn s maBC@ag o

ShowMass _ In-Place Place Curtain | Roof | Wall Floor Toposurface Site Parking Building  Splt | Subregion Property Graded Label
by View Settings Mass  Mass  System Component Component Pad  Surface Surface Line Region | Contours
Select = Conceptual Mass Model by Face Model Site 0 Modify Site

« [STEP 2] Set your topo lines
The increment number depends on your site map scale and how much detail you want to express
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Site Settings

Contour Line Display
[] At Intervals of: Passing Through Elevation:
Additional Contours:
Start | Stop [ Increment | Range Type Subcategory A
1]-1000" :1000" 0:5' 0" Multiple Values Secondary Contours
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[¥]
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Clean up the imported CAD map

[STEP 1] Select the imported CAD map

[STEP 2] Click [DELETE LAYERS] from [MODIFY], under [[IMPORT INSTANCE]

[STEP 3] Check all except [BUILDING]
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« [STEP 4] Click [OK] to finish the command
« [STEP 5] Check [CROP VIEW] to see only the region inside
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Confirm your topo in 3D

Revit is BIM software. Your 2D drawings can show in 3D. It is wise to double-check in 3D view while you build your model

+ [STEP 1] To create a 3D view, click the 3D view on the top of the program
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« [STEP 2] Once you click the 3D view, the 3D view will automatically open. To refer back to this view, you can open the
3D view on Project Browser by double-clicking. If you want to keep the view, you must rename the 3D view. For
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» [STEP 3] Click [SHADED)] to see the color
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+ [STEP 4] Check [Section box] on the Properties and adjust the Section box by adjusting the blue arrow
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« [STEP 5] Click [Sun path On]
» [STEP 6] Click Shadow
« [STEP 7] Now you can simulate the sun path by drag and dropping the sun
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Create Building Pod & Property line

For the building pod and property line, you should hide the Topo image by clicking the image, and mouse right-click and
select [Hide in view] > [Elements]

« [STEP 01] Go to Site & massing tab — Click [Building Pad]

« [STEP 02] Make sure your building pod is on level 1

» [STEP 03] Draw a closed line

« [STEP 04] Go to Site & massing tab — Click [Property Line] — Create by sketching
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« [STEP 05] Use Google Map to draw the property line. Draw a closed line
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Create Roads

+ Go to Site & massing tab — Click Subregion
+ Draw a closed line

temte OF Larm2 o mide

Create Neighborhoods (Trees)

+ Go to Site & massing tab — Click Site component
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Once you finished your site plan, you should hide the Google image.
SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)

i\ References

Archibald & Fraser Architects Ltd. (2012, November 10). Lochaber Centre Site Plan jpg. Retrieved October 22, 2020, from
https://commons.wikimedia.org/wiki/File:Lochaber_Centre_Site_Plan.j

Site Planning Process Chesterfield County, Virginia Planning Department. Accessed 11 Feb 2009. Archived March 29, 2009,
at the Wayback Machine

Google. (n.d.). Google map. Retrieved October 23, 2020, from https://www.google.com/maps

Worldwide map files for any design program. (n.d.). Retrieved October 23, 2020, from https://cadmapper.com/

Revit Session 2 | 140



Chapter 10. Set grids, levels, dimensions, &

building columns

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Import CAD drawings- Floor plans, building elevations, and sections
(CO 2) Adjust and verify the scale

(CO 3) Create and modify grids and levels

(CO 4) Create plan views- Floors and ceilings

(CO 5) Create columns

’ Session Highlights

At the end of the session, students can create the graphics below.

v ¢ ¢ 2 ¢ ¢ 9 9
D T e e e S S S
e e A e N
N e e e N R
B i B S e s s s
| | | | | | | | |
L e e N A
e e e S e
I e B
D SR R SN SR S S R

| |
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E Lecture Contents

(CO 1) Import Drawings- Floor plans, building elevations, and sections

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/
visualgraphiccomm/?p=92

Prepare Drawings before import CAD drawings

+ [STEP 1] Open Revit application > Open your project > Double-click [LEVEL 1] from [PROECT BROWSER] > Close
all other views except [LEVEL 1]

+ [STEP 2] Select [SITE] information including the property line, trees, and neighborhood buildings > Mouse right-click
on one of the selected elements > select [HIDE IN VIEW] > Select [ELEMENTS] or [CATEGORY]

A ) B e s
112 Views (all]

—'*- B

Fepent [Hide Elements|
Facent Commands

Legens:
[ Schedales/Tunntites (]
[ Shests (o1)

3 B Farvslien

g i Groups
o Rt Links

Repeat this process for FLOOR PLAN — LEVEL 2, ELEVATION - EAST, WEST, NORTH, SOUTH, CEILING PLAN -
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Insert drawings

In this tutorial, we will practice how to add an image (drawing) to the view. You can insert CAD files and PDF files

« [STEP 1] Select [IMPORT IMAGE] from [INSERT] tab, under [IMPORT] panel
Note. Revit can import various file types — dwg, dxf, pdf, jpg, tif, rvt, and more
Note. For this project, I will use [tif] files

Il Aechitecture (TER) Annctate  Analyze  Massing & Site  Collt View Manage Add-lns  Modiy @~
- on =h = . U = m O [(ﬁ 5
s Bt B O9e @ mallfe i 3
Modify| Link Link Link Link DWF  Decal Point Coordination Link Link Manage (Import|Import fmport] Load Get Autodesk Loadas  Insert
Revit IFC CAD Topography Markup ' Cloud  Model PDF Image Links CAD | PDF Family Content  Group from File
Select = | tmnart cAD rpun l Load from Library

« [STEP 2] Find the folder where the drawings are saved > select the floor plan > click [OPEN] > place the imported
image on the view [LEVEL 1]

Repeat this process for FLOOR PLAN — LEVEL 2, ELEVATION - EAST, WEST, NORTH, SOUTHNote. The imported

image will only show on the view where you placed.
Note. To use the image file that you imported for your other level like [LEVEL 2]. Click [MANAGE LINKS] > Click
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[IMAGES] tab > Click the image that you loaded in the model > Click [PLACE INSTANCE]
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(CO 2) Adjust and verify the scale

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/

visualgraphiccomm/?p=92

Confirm the scale and position of the imported drawings

If the imported image/CAD file/PDF is in the right scale and position, skip this one, but double-check for your accuracy

« [STEP 1] Select imported image > click [SCALE] from [MODIFY] tab, under [MODIFY] panel

Revit Session 3 | 144



B 2chtectwe  dnset  Anmotste  Spabee  Messing &Sie  Collsborste Vi

bl O XKee-DD Bl

s =
. o= e

I Peut - By
Modity  [JI on =4 - 3 28 Menge
= g ea o8e 92 M L8] *) &% ks
Select = Properfies  Clipboard | View  Messure Create Image Armnge
G

Properues

o | e PR . S—— : e g

TTE it
sia| T T 1
T [ [
A i L f :

i Eﬁ

iHIEHNIE AR

i e AR OO MRATRTN

— T |

« [STEP 2] Click the first point that you know the dimension. I will use the overall building dimension (58"-7"). You may
also use a graphic scale if you have one
You need to zoom in to select the first point in the middle of the dimension line.

Grphes

« [STEP 3] Click the second point
« [STEP 4] Type the dimension [58'7"] and press [Enter] key
« [STEP 5] Zoom out to see the position
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+ [STEP 6] Move the drawing to match the base drawing. You can use a specific point to match the drawing to the base
Revit model that you created
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You may need to change the graphic display to [WIREFRAME] to see the image behind the model
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Repeat this process for FLOOR PLAN - LEVEL 2, ELEVATION - EAST, WEST, NORTH, SOUTH
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(CO 3) Create and modify grids and levels

A YouTube element has been excluded from this version of the text. You can view it online here: https.//iastate pressbooks.pub/

visualgraphiccomm/?p=92

Create grids

« [STEP 1] Open [LEVEL 1] view

+ [STEP 2] Select [GRID] from [ARCHITECTURE] tab, under [DATUM] panel

« [STEP 3] Using the straight-line selection, hover over the view near the west wall until it becomes highlighted in the
center of the wall and an “X” appears
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, FIRST FLOOR PLAN Il

-1

S
« [STEP 4] Click the first point and click the second point to complete the gridline 1
+ [STEP 5] To complete the remaining gridlines, you can copy or continue drawing gridlines based on the imported
image
« [STEP 6] To copy, select the Revit gridline 1 that you just made. Select the Copy tool and click a point and specify the
second point to the next grid line
« [STEP 7] Also you should use dimension [DI] to specify the distance between gridlines

ot 1 [

W | —] x'/ .. " ! ™,
n‘::'::. + f \ f \ ot
: ( } : I e

| L B/ = Elevatians [Bulkfivg Sevatien]
7 Y . Eat

- v 1 o
7' 4.;5 ?'_E;_:" 7 -5% B Sehecilan Chcamtition ol

« [STEP 8] Continue to copy all North/South gridlines
+ [STEP 9] If the grid bubble and numbers are too big, you can update the view scale by clicking scale. For the Eames
House project, use 3/8" = 1'-0”
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« [STEP 10] Create a Horizontal new grid for East/West. And Update the Grid name to [A] and complete East/West grids
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+ [STEP 11] Your gridlines and dimensions can be locked
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« [STEP 12] Open [NORTH] view and adjust the grid line heights by dragging and drop the edge of the grid line. And
repeat this for [WEST] view

149 | Revit Session 3



Create and Modify levels

+ [STEP 1] We will now make Levels. Begin by navigating to the [SOUTH] elevation in the Project Browser.

o Adjust the length of the level by dragging and drop the edge of the level line
o Repeat this for [EAST] elevation view

« [STEP 2] After you have confirmed that Levels 1 & 2 are set to the correct elevation, you can add additional levels. To
adjust the elevation number, click on the number and type in the correct elevation.
Note: Level 2 will be [9’-7"] higher than Level 1.

.......

» [STEP 3] Add a roof level.

o Select [LEVEL] from [ARCHITECTURE] tab, under [DATUM] panel
Or, type [LL]
o Click the left corner of the level and click the second point to finish the command
> Rename [Roof] > Click OK in the window pop-up and change the view name accordingly
o Adjust the height to [18’ 5 1/2"]
« [STEP 4] If you copy (COjthe level from the existing level, the view will not be created. Create Ground and Level 1 top
(Black symbol)
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« [STEP 5] Update the view scales

= 3/16” = 1’-0” for all elevations
= 3/8"=1-0" for floor plans and ceiling plans
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(CO 4) Create plan views- Floors and ceilings

A YouTube element has been excluded from this version of the text. You can view it online here: https_//iastate pressbooks pub/

visualgraphiccomm/?p=92

Currently, you have what you need. When you add a new level [LL], the views automatically created. If you made the view
by coping existing levels [CO], you have to create new views for the level

« [STEP 1] Select [PLAN VIEWS]

« [STEP 2] Select [FLOOR PLAN] if you need a floor plan
« [STEP 3] Select [NAME OF THE LEVEL] and click [OK], then you can find the view from [PROJECT BROWSER]
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If you need additional plans for furniture plans, power, and data plans, and finish plans, you need to duplicate the view by

mouse-right clicking and select duplicate view > duplicate

Note, there are three options for duplicating views. Please refer to this link for further explanation

(CO 5) Create columns

visualgraphiccomm/?p=92

A YouTube element has been excluded from this version of the text. You can view it online here: https_//iastate pressbooks pub/

We will now add columns beginning on the Ground level

» [STEP 1] Under the Architecture tab on the Ribbon select Structural Column.
Analyze  Massing & 5ite  Collaborate  View Manage Add-ns  Modify &1

o8 ) o et
O3 8 @ [U

Modify| Wall Door Window Component | Column

Select =

| Chemirioat Fiatsioman 1

» [STEP 2] Select the 5" x 5" column.

o
| » . A - ] d . 0 1
FECEEE BOOAILRKEE B KX ¥ X 21
Roof Ceiling Floor Curtain Curtain Mullion  Railing Ramp Stair  Model Model Model | Room  Room Tag _ Area Tag By ¢
e i System  Grd " Tet Line Group Separator  Room e Area Face
Circulation Model Room & Area =
[ Level2 # South # West I Levet 2 [ Levet1 . North  Eax

Note: an existing column family may need to be edited to create this size by clicking [EDIT TYPE] > Click
[DUPLICATE] > add name [W5x 5] > click [OK] > update width and height to 5”
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+ [STEP 3] Confirm the Base Level is set to Ground and the Top Level is set to Roof
+ [STEP 4] Place a column on your [LEVEL 1]
+ [STEP 5] It will be necessary to Move [MV] and Copy [CQO] the Revit columns to align as shown on the imported floor

plan and the grid that you created

Hide the imported drawing image to confirm all columns are properly placed

Type [TL] to see the thick lines for print
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SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)

ﬂ\ References

Autodesk.Help. (2007, September 13). About Duplicating Views in Revit. Retrieved October 22, 2020, from
https://knowledge.autodesk.com/support/revit-products/learn-explore/caas/CloudHelp/cloudhelp/2018/ENU/3PP-
RVT-ARCH-ASCENT/files/GUID-F4ABE31C-D4D8-45FB-A628-A512D41D8114-htm.html
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Chapter 11. Add/edit beams, walls, & curtain
walls

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Add/Edit Beam

(CO 2) Create walls

(CO 3) Edit walls wall properties — Wall thickness, Wall details, & Finishes
(CO 4) Edit/add wall properties — Wall opening, wall sweep

(CO 5) Add/Edit Curtainwalls, Mullions, & Panels

Q Session Highlights

At the end of the session, students can create the graphics below.
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Traztioss v 1 tr BE G GGaAREY  mEE
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E Lecture Contents

(CO 1) Add/Edit Beam

A YouTube element has been excluded from this version of the text. You can view it online here: https_.//iastate pressbooks pub/

visualgraphiccomm/?p=94

Adding beams are not typical for interior design projects, but it is needed for the Eames House project. You may use this
information for an open ceiling plan of commercial projects as well.

You can find [BEAM] from the [STRUCTURE] tab, under the [STRUCTURE] panel.
[ZI  Architecture Precast Insert Annotate Analyze Massing & 5Site  Collaborate  View Manage Add-lns  Madify

)0 0 CWHED & & Lo (J# IJBRBO:

Meodify| | Beam Wall Column Floor Truss Brace Beam Connection Isolated Wall SIab Rebar Area Path Fabric Fabric Cover
K System Area Sheet C

Select = Structure s Connection = » Foundation Reinforcement =

If you are missing the Structure tab, click [HOME] menu > Click [OPTION] > Click [USER INTERFACE] > Check
[STRUCTURE TABL AND TOOLS]

Options X

General ‘ Configure

NRerIntestice Teols and analyses:

V| Architecture tab and tools A
Graphics I Structure tab and tools

[l Steeltab and tools
@ Hardware 1 Structural analysis and tools

4— File Locations [[] Systems tab: mechanical tools |
eoase ¥ Segg i eoane

Mechanical analysis tools

—:f — - — - | Rendering [l Systemstab: electrical tools o —.F —_——-—
]
1

Hectrical analysis tools i

Ehiee el [] Systems tab: piping tools |
1

SteeringWheels Piping analysis tools v

To see the structural element in solid shapes instead of lines, the view detail level must be [FINE]. Please update all floor
plans, ceiling plans, and elevations to [FINE] on a detail level.

[J Coarse
=1 Medium

Add Beams

» [STEP 1] Click [Beam] on [Structure]
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